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Information and Communications Technology-IX

THE NATIONAL ANTHEM

Jana-gana-mana adhinayaka jaya he

Bharatha-bhagya-vidhata,

Punjab-Sindh-Gujarat-Maratha

Dravida-Utkala-Banga

Vindhya-Himachala-Yamuna-Ganga

Uchchala-Jaladhi-taranga

Tava subha name jage,

Tava subha asisa mage,

Gahe tava jaya gatha.

Jana-gana-mangala-dayaka jaya he

Bharatha-bhagya-vidhata,

Jaya he, jaya he, jaya he,

Jaya jaya jaya jaya he!

PLEDGE

India is my country. All Indians are my
brothers and sisters.

I love my country, and I am proud of its rich
and varied heritage. I shall always strive to
be worthy of it.

I shall give my parents, teachers and all elders
respect, and treat everyone with courtesy.

To my country and my people, I pledge my
devotion. In their well-being and prosperity
alone lies my happiness.



Dear learners,

The Information and Communications Technology
textbook for Standard IX is prepared and presented to you with
the firm conviction that the ICT textbook for Std VIII was
successful in guiding you across the marvellous and ever
advancing world of information and communications
technology and in providing you with various innovative
learning experiences.

You have already learnt the basic lessons of Graphic
Designing. This textbook has been prepared with the intention
of providing you with practice in using graphic software for
designing posters and pictures by yourself for curricular and
extracurricular activities, familiarizing you with the various
possibilities of word processor, equipping you to use software
like spreadsheet, presentation, etc. for doing various activities
including projects.

The activities included in this textbook are designed using
various interactive software like GeoGebra, RasMol, GPlates,
Stellarium, etc. which will help you to get a deeper
understanding of the various concepts. The textbook also
initiates you into the world of computer languages by providing
opportunities to prepare programs using Python. In addition
to familiarising the various services provided through internet,
the textbook also offers practice in handling Wiki software.

This textbook that provides you with interesting and novel
learning experiences will prove to be a good companion to you
in the learning of other languages and subjects.

Dr P.A.Fathima
Director

SCERT, Kerala

Preface
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Icons used in this book
for easy reference

For further reading
(Not to be evaluated)

Let’s evaluate

Follow-up activities

Significant learning outcomes
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Layout of Pictures

Information and Communications Technology - IX

Every year June 12 is observed as the World Day

against Child Labour as per the directive of the

International Labour Organisation which is an agency of

the United Nations. Varsha and Saleena are having a

discussion on  the Poster Designing competition to be

held in the school in connection with the World Day

against Child Labour.  They decide to design a poster

with the help of their computer highlighting the slogan

“Education for All”.

“Imagination is the source of every form of human achievement.’’

                         - Ken Robinson

Chapter 1Chapter 1Chapter 1Chapter 1Chapter 1

Layout of Pictures

Don't you have to
include more than one

picture in the
poster?
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Information and Communications Technology - IX

You can also design attractive posters using pictures,
logos etc. with messages against child labour. You may
be aware of the fact that numerous graphics software are
available which will help you in this.  We have already
learnt in the chapter The Wonderland of Pictures in
Standard VIII how the image editing software GIMP can
be used to prepare cover page, logos, etc.

What  all features of the graphic software GIMP do
you know? Let’s list them.

♦ Create copies of images.

♦ Separate the parts of images.

♦ Include letters in the picture.

♦ ...........................................................................................................................

♦ ...........................................................................................................................

Shall we design a poster using GIMP software? What
are the preparations to be done before designing a poster?

♦ Collect pictures required for preparing the poster in
your computer.

♦ Provide suitable background colour for the poster.

♦ Include all the pictures/images or parts of the images
based on the topic, on a canvas in such a way that
they communicate the idea.

♦ Make the poster attractive using the provisions in
Image Editing.

♦ Include a message in the poster.

Activity 1.1 Let’s collect pictures

Download the pictures necessary for the poster from
the Internet and save them in the Images folder of your
class folder. Ensure that your class folder is there in
Students_Work_9 folder in Home.

Where will I
get the

pictures from?

Image editing

The process of making
changes in an image with
the help of a software is
called image editing.
Today, it is possible to
create your picture as
standing fearlessly in the
deep forest with wild
animals around. Such
pictures are prepared
using Image editing
software.  Software like
this can be used to crop
images, resize them,
change the colour and to
combine images.  The
same image editing
software can also be used
to create characters for
animation. GIMP,
Photoshop, Krita, Picasa,
Image Magic, etc. are
some Image Editing
software.

GIMP helps to;
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What are the other methods in which you can collect
pictures? Let’s list some of the methods you have learnt
in your previous classes.

♦ Capture pictures using digital camera and save them
in the computer.

♦ Scan pictures and news clippings that appear in
newspapers and magazines.

♦ ............................................................................................................................

♦ .............................................................................................................................

  A poster that creates awareness/communicates a
message can be designed suitably by arranging the words
and images appropriately. A canvas is essential in GIMP
to arrange the images and letters. So you can open GIMP
and create a canvas. Don’t you remember how a canvas
is created using GIMP?

Activity 1.2  - Let’s colour the canvas

Imagine that the poster you are going to design,
should contain a background colour which is a
combination of two colours. Using the hints given,
provide a suitable background to the canvas you have
created.

Illustration of the structure of

the folder in which the file is to

be saved

Pic. 1.1 Window and toolbox to create a new canvas in GIMP

Size of the canvas

In GIMP, the size of the
canvas is measured in
pixel units.  In addition to
pixels, you can also
select canvas in other
units like centimeter,
millimeter, inch, etc.
from Create a New Image
window.  Here (in Pic.
1.1), a canvas of A4 size
is created. There are
many templates
prepared and stored in
GIMP in the similar
manner. You can also
create a canvas  by
providing values in
Width and Height boxes
in the window.
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♦ Select the suitable foreground and background colour

using the Foreground & Background Colors tool.

♦ Click on Blend tool and then drag and apply colour

to the canvas.

Activity 1.3 - Arrange pictures on the canvas

The poster is designed using one or more pictures.

So, you will have to bring the pictures one by one to the

GIMP canvas. Open the picture you would like to include

in the canvas first from the pictures you have already

collected. Don’t you remember how pictures can be

opened in GIMP? Now, do you need the whole picture

or only a part of the picture for your poster? You can use

the selection tool to select either the whole picture or part

of the picture. Open GIMP and observe the various

selection tools in it (Pic. 1.2).

Now, let’s see how a part of the picture is selected
and pasted on the canvas.

Don’t you see a white logo in Pic. 1.3?  The areas in
the image with the same colour can be selected on the
basis of colour using the Select by Color tool. You may
follow the steps given below:

♦ Open the picture in GIMP.

♦ Click on the Select by Color tool in the toolbox to

activate it.

♦ Click on the colour you wish to select  from the picture.
(Here the picture is the logo of ILO). You can
see that all the white coloured areas have been
selected.

♦ Click on the Edit menu of the picture window
and select Copy (Pic. 1.3).

♦ Click on the Edit menu of the canvas window
you have prepared for the poster and select
Paste. (It is better to keep the canvas window
open right from the beginning).

Pic. 1.2
Toolbox in GIMP

Selection tools

Pic. 1.3 Edit Window

Save your Canvas with the
file name Poster in your
folder.
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Now, you have pasted the pictures on the GIMP
canvas.  When the pictures are pasted on the canvas, they
appear on the canvas with a floating layer or floating
selection. (Pic. 1.4)  By clicking on the Anchor tool in the
Layer Palette, you can avoid the floating selection and
fix the picture to the background.

Now, try to move the picture you have pasted on
the canvas.  You can use the Move tool.

Were you able to change the position of the pasted
picture? Does the background move along with the
picture?

What may be the reason for this? Here, the picture is
pasted on the background.

If you wish to skip the last action and go back to an earlier
action, click on Edit →→→→→ Undo of the canvas.

To edit the pictures we have pasted on the canvas, it
is better to use the provision of Layer in the Image Editing
software. To understand more about layer, read the note
on Layer editing.

Now, you might have understood that the pictures
moved freely because they were not pasted using layer.

Shall we try to do this activity by pasting the
previously copied image on a new layer according to the
instructions given below?

♦ Paste the copied image on the canvas of the poster.

♦  Click on To New Layer in the Layer menu.

Now, what change has taken place in the Layer
palette? You can see that the picture is pasted on a new
layer.

You must specially note that in this case, there was
no need to anchor the picture.

Pic. 1.4 -
Floating layer

Floating layer/
Floating selection

Floating layers/floating
selections are temporary
layers that have the same
features of a normal layer.
A floating layer persists
only till layer editing is
done or till you begin the
next layer editing. To
anchor the image pasted
on the floating layer to
the background or the
selected layer click on
Anchor tool in the Layer
menu.
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You are already familiar with the Select By Color tool.

Now, open the pictures you have collected and with
the help of the selection tools, select the parts of the picture
required. Using the Copy and Paste tools, insert the
pictures as various layers in the poster window.

Observe the uses of other Selection tools in GIMP
and complete Table 1.1. When you place the mouse
pointer on each tool in the selection box, the features of
the tool will appear as tool tips.

Pic. 1.5 GIMP canvas                 Pic. 1.6 Layer Palette      Pic. 1.7 Layer Properties window

Layer editing

Layers are an inevitable part of any Image Editing software. Each layer exists
independently. Usually, in image editing we have to process several images at the
same time. In such circumstances, if each image is arranged in a separate layer,
they can be edited independently.

To add new layers, click on the icon  in the Layer Palette (Pic. 1.6). The

portion which has the tools required for creating and copying layers is the Layer
Palette. Duplicate layers can be prepared and the position of layers can be changed
using the various tools available in the Layer Palette.  Normally, transparent layers
are used in GIMP to create new layers (Pic. 1.7). If the Layer Palette is not visible in
GIMP then, select Dockable Dialogs from the canvas Windows menu and click on
Layers.
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You can create a new layer just before pasting the

copied picture. For this, click on New Layer  on the Layer

Palette after pasting the picture. (Pic. 1.6)

You have included all the pictures required for the

poster, haven’t you? Now, using Move tool, arrange the

pictures in suitable places.

Changing the size of the picture as required will

make the poster more beautiful and attractive. To change

the size of the picture, activate the Scale tool and then

click on the picture. Now, provide the necessary

measurements as length and width and click on the Scale

button.

After arranging the required pictures for the poster

on the canvas, observe the Layer Palette (Pic. 1.9). You

know the layer in which the background is pasted. But,

what about the other pictures? Can you make out on

which layers they are placed? Providing names related

to the picture to each layer will make image editing

easier. To find out how a new name is given to a layer,

do the following activities.

Selection tool Short cut key Uses

Rectangle select R To make a rectangle shaped selection

Ellipse select

Free select

Fuzzy select

Select by colour

Scissors select

Foreground select

.........................

.........................

.........................

.........................

.........................

.........................

................................................................................................

................................................................................................

.................................................................................................

................................................................................................

................................................................................................

................................................................................................

Table 1.1 Short cut keys and uses of selection tools

Do not Forget!!!

After each action do not
forget to click on the Save
button in the poster
window to save your
work.
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Activity 1.4 - Let’s rename the layer

♦ Open the Layer Palette.

♦ Right click on the layer to be renamed. (You can also
double click on the layer.)

♦ Select Edit Layer Attributes.

♦ Type a new name in the place of the existing name in
the window that opens up.

♦ Click on the OK button.

Activity 1.5 - Place a logo in the poster

By including a suitable message, we can make the
poster more communicative and catchy. Did you notice
that the message ‘Say No to Child Labour’ in the poster
(Pic. 1.8).  This has been done using the provision of Logo
in GIMP. You have learnt how to create logos in your
previous class, haven’t you?

Amil faced a difficulty when he tried to include the
logo in the poster using Copy, Paste features. The
problem was that he could not paste all the parts of the
logo on the canvas.  Why did this happen? Let’s find out.

Observe the Layer Palette in the Logo window. (Pic.
1.11) Can’t you see more than one layer?  When we copied
the logo, only the active layer was copied.

Pic. 1.9 Layer PalettePic.1.8 Poster

How can we find out
in which layer is each

picture pasted?
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The facility to copy all the layers that are visible in

a logo is available in GIMP. This tool is termed as Copy

Visible (Edit→Copy Visible). Try to copy the logo and

paste it on the canvas using this facility. Now, the

completed Logo will be visible on the poster.

In that case, how can we paste the text of the logo on

the poster?

Don’t you see an eye shaped icon (Eye Icon) on the

Layer Palette of the logo (Pic. 1.11)? What happens if you

click on this icon? When the picture of the eye disappears,

the layer on the logo window gets hidden. Try to copy

after hiding the layers other than the text layers. Don’t

forget to use the Copy Visible tool when you copy the

text. Use the Move tool to arrange the pasted logo in the

suitable position. Click on the Save button to save the

changes made to the poster.

Haven’t you come across many instances in which a

layer once created on the poster had to be avoided? For

this, right click on the particular layer of the Layer Palette

and select Delete Layer.

GIMP is the graphic editor that includes many tools

which help in Image Editing. Let’s learn about some of

these tools that help in making the poster more attractive.

Activity 1.6 - Paths tool for selecting a picture

Paths tool is a tool that helps in selecting a part of an

image according to a fixed shape. Paths tool can also be

used to create different types of Patterns and also to select

a certain part of the image.

 Pic. 1.10 Logo

Pic. 1.11 Layer Palette
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Suppose you have to separate only a part of the
picture  (Pic. 1.12) and include it in the poster, how will
you do it?  Follow the steps given below.

♦ Open the picture in GIMP.

♦ Select Paths tool from the toolbox.

♦ Click on the edges of the picture as shown in Pic. 1.12
Step 1.

♦ Press the Ctrl key and click on the point where you
start to complete the marking.

♦ Select From Path tool from the Select menu to mark
the path of the selected portion (Pic. 1.12 step 2).

Thus, the selection is completed.

♦ Use the Copy → Paste tool to insert the picture in
the poster.

♦ Adjust the size of the image to suit the poster and
save it.

Pic. 1.12 Various steps/stages while using Paths tool

Do you know?

If the default settings in
GIMP is changed, there
are provisions  available
in GIMP to reinstate the
default settings.

The  following steps will
help you.

♦ Click on the Edit
menu in the GIMP
window and select
Preferences.

♦ Click on Window
Management in the
window that opens.

♦ Click on Reset Saved
Window Positions to
Default Values and
give OK command.

♦ Restart GIMP.
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Activity 1.7 - Change picture clarity

Imagine that you want to improve the clarity of a

picture you have selected to be included in the poster.

For this, first open the picture in GIMP and follow

the steps as given below.

♦ Make a the duplicate of the picture of which you

would like to change the clarity.

♦ Click on the Colors menu of the GIMP window and

open the Brightness - Contrast sub-menu.

♦ Move the slider in the window that opens. Change

the brightness and contrast of the picture. Observe

what happens.

Imagine that the picture of a boy who is engaged in

child labour is to be included in the poster. But the face

of the boy should be blurred. This was the problem faced

by Rithu. You might have faced the same problem. Let’s

do the activity given below.

Activity 1.8 - Filter tools

To make the face of the boy blurred in the poster

you have prepared, use the Blur tool in the Filter menu

in GIMP. Follow the steps given below.

♦ Select the layer which includes the picture that you

have to blur. (Click on the layer which has the picture

in the Layer Palette.)

♦ Using the selection tool, select the portion of the

picture to be blurred.

♦ Select a suitable blur tool from the Blur menu that

appears when you click on the Filters menu.

Now we can observe that the part of the image we

have selected is in a blurred manner.

Many filter tools are included in GIMP. Hope you

will use the other features available in the Filters menu.

During image editing,
remember to close the picture
windows which you have
finished working.

Flip images

Provisions are available
in GIMP to flip the
images to either sides.
Follow the process given
below to do the activity.

♦ Make a copy of the
layer that includes the
picture to be flipped.

♦ Using the Move tool,
arrange the copied
image on the canvas.

♦ Click on the Flip tool
in the toolbox and
activate it.

♦ Click on the image
you intend to flip.
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Now, you have almost finished the poster.  To include
the completed poster in a presentation, export it in jpg
format and save it in the concerned folder. You have learnt
how to export a file in your previous class.

The learner:

♦ identifies the uses of the various selection tools and prepares a table.

♦ creates new layers on a canvas and designs a poster including pictures, logos, etc.
and saves it.

♦ lists the process to create paths for images using Paths tool.

♦ changes the brightness and contrast of an image and includes it in the poster and
saves it.

♦ uses the Blur tools in the Filters menu to blur the selected portions of an image,
includes it in the poster and saves it.

1. Open a canvas in GIMP, paste a picture and anchor it. But, when you try to move
the pasted image, it moves along with the background.  What could be the reason
for this?

a) The picture did not get pasted on the canvas.

b) The picture was pasted on the background of the canvas.

c) The Move tool did not function properly.

d) The picture format did not support the process.

2. Prepare a banner to be held in a rally to be organised in connection with the
proclamation procession of the World Environment Day. Include the details given
below and save it in your folder.

Hints:

� Use Logo tool and include the slogan No forests No Man in an attractive manner.

� Include pictures that depict causes for the destruction of the environment.

� Save the banner in xcf and jpg formats in your folder.

Let’s evaluate

Significant learning outcomes
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3. From the procedures given below, choose the correct one which is used to rename
a layer in GIMP.

a) Click on the canvas. b)  Click on the Layer Palette.

c) Right click on the layer. d)  Click on the Floating layer.

4. Design a poster using GIMP to create awareness about the importance of organ
donation. Make use of the details given below.

Hints:

♦ Include a message in the form of a logo on the importance of organ donation.

♦ Arrange the pictures of the organs of the human body in an attractive manner.

♦ Export the poster in png format.

Follow-up activities

♦ Your class is preparing a science magazine based on the unit Food for the Living
World of your Biology textbook. The magazine explains the contributions of
scientists who explained the procedure of Photosynthesis. Prepare a cover page
for the magazine using GIMP.

♦ Design and exhibit posters in GIMP that highlights the message Cleanliness of the
surroundings is as important as Personal Hygiene.

♦ Organise a digital poster competition on the topic Wars Lead to Total Destruction.

♦ Organise a collage designing competition on the topic Traditional food and fast
food to be conducted by the School Health Club. Take ideas from the unit Beyond
the Sense of Taste in your Biology textbook.
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Vipin and Varsha are getting ready for a paper

presentation at a seminar to be held in connection with

the Vidyarangam Literary Fest. They are about to type

the written matter with the help of the computer and take

a print of it. Which software can they use for this?

You are familiar with the preparation of such files in

the word processor. Files prepared in this manner can be

arranged in various ways, edited, enriched and printed.

Just like Vipin and Varsha, we can also prepare a seminar

paper in the word processor in an attractive way.

The first step is to type the seminar paper in the word

processor. You have practiced typing in the mother

tongue using word processor in your previous class.

Some of you may face difficulty in typing chillu letters

(chillaksharangal) and compound letters

(koottaksharangal). Let’s try to recollect how it was done.

Find out the letters which combine to form the

following chillaksharangal and koottaksharangal and

complete the table (Table 2.1).

Now, type these chillu letters and compound letters
in the computer.

Chapter 2Chapter 2Chapter 2Chapter 2Chapter 2

Setting the Page

My seminar
paper

is ready

Now, we shall
type this in the

computer and get
a print.
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Activity 2.1 – Let’s digitize the seminar paper

Open the word processor and type the content of the

   paper.  Don’t forget to save the typed document. You have

learnt in the previous class how files prepared in the word

processor are given a name and how they are saved in the

concerned folders.

The picture (Pic. 2.1) shows the first page of the

seminar paper prepared and saved by Vipin and Varsha

just as you did. Doesn’t your seminar paper also follow

the same model? Now, observe the next picture (Pic. 2.2).

Here you will see that they have made many

improvements to the paper. What improvements have

they made? Note down your observations.

♦ Adjusted the size of the font.

Letter Compound letters

° I +  v + I

º

£

{X

©

¿

≥

ƒ

¨

¬

Table 2.1 Cillaksahrangal and Koottaksharangal

Pic. 2.1 An unformatted page



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

22

Setting the Page

Information and Communications Technology-IX

♦ Changed the font.

♦ Adjusted the spacing between the paragraphs.

♦ Provided background colour and borders to the
page.

♦ ..............................................................................................................

♦ ..............................................................................................................

♦ ..............................................................................................................

You might have learnt in the previous class,

various methods to edit letters and paragraphs.

Activity 2.2 - Let’s layout the page

Just as the letters and paragraphs were formatted in
an attractive manner, the page also can be made attractive.
Open the Page Style window (Pic. 2.3) and examine the
facilities available there (Format →→→→→ Page).

♦ Click on Page tab and type suitable values in the
Margin box to adjust the page margin.

Pic. 2.2  A formatted page

Now, in the seminar paper you have typed and prepared,

adjust the font colour, font size, font style, line spacing,

etc. so as to  make it attractive (as shown in Pic. 2.2) and

save it.

Superscript and Subscript

You may come across situations where you have to type mathematical equations and

chemical formulae like a2+2ab+b2, H
2
SO

4
. Have you noticed that in the terms a2 and b2, 2

is placed a little above the other letters? This is called superscript. Likewise in H
2
 and O

4
, 2

and 4 are placed slightly below the other letters. This is called subscript.

To type numbers or letters as subscript or superscript, first select the number or letter.

Then, from the Position tab in the Character Format window, select subscript or superscript.
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♦ You can select the page size from Paper

Format on Page tab. (Since our seminar

document has to be printed, selecting A4 size

is preferable.)

♦ Select either Portrait or Landscape from

Orientation to set the page orientation

vertically or horizontally.

Now, provide background colour to the

page to make it look attractive. For this, click

on Area tab in the Page Style window. From

Fill option select the required colour.

Activity 2.3 - Let’s provide borders

Don’t you think that the seminar paper will look more
attractive if we provide page borders? How can we do
so?

♦ Click on the Borders tab in the Page Style window.

♦ From the Line Arrangement option you can select the
portion where you wish to provide borders.

♦ From the options given below the Line option, select
the Style, Width, Color, etc. of the border.

You can also adjust the spacing between the border

and the words here. For this you can select Spacing to

Contents and make necessary changes in the values in

Left, Right, Top and Bottom. By selecting a suitable style

from Shadow Style, you can also give a shadow to the

border.

Activity 2.4 - Let’s insert header and footer

Open your textbook and look at the top and bottom

portion of each page. Have you noticed the page number,

name of the book, name of the unit, your standard, etc.

appearing repeatedly on each page? Can we also include

such repeatedly appearing details (name of the seminar

paper, page number, etc.) in the pages of our document?

Shall I make the page
more attractive?

Pic. 2.3 Page Style window
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It will be convenient to include such repeatedly

appearing details in the Header and Footer. The

header appears at the top of each page and footer at

the bottom. Let’s see how the page number is inserted

as a header.

♦ Click on the Header tab of the Page Style window.

Put a tick mark in the Header option and click OK

button. Now, the header will appear at the top of the

page.

♦ Click on the header and insert the page number. (Insert

→→→→→ Fields →→→→→ Page Number).

Now, examine the pages. Does the page number

appear on each page? In the similar manner, insert as

footer the title of your document on one page and the

name of your school in the next page.

Did you face any difficulty in inserting different

contents as footer in the pages?

Click on Footer tab and remove the tick mark on Same

Content Left/Right. Now, insert the title of the seminar in

the first page and the school’s name in the second page

as footer. Doesn’t the footer of the left and right pages

appear as you wished?

Activity 2.5 - Let’s arrange in columns

Observe how the content of the old IT textbook of

Class 9 is presented (Pic 2.4). The information is arranged

in two columns. Doesn’t this arrangement look more

attractive and impressive? Shall we arrange our seminar

paper also in this manner? What should we do for this?

♦ Click on the Columns tab of Page Style window.

♦ Provide the number of columns required in the

Columns seen in Settings.

♦ Adjust the width and spacing of the columns using

the Width and Spacing option.

Picture as page
background

Just as we gave a colour
as the background, we
can also give a picture as
the background. For this,
select Bitmap from the
Fill option in Area tab.
Click on Import Graphic
and select the picture to
be included as back
ground. Click on Open
button and the picture
appears as the
background of your page.
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♦ Column width will be adjusted equally if there is a

tick mark against AutoWidth. But, if we remove the

tick mark we can adjust the width and distance of the

columns according to our requirement.

Now, arrange the text of the seminar paper in

columns and save it.

Activity 2.6 - When pictures are inserted

Don’t you think you should include pictures in your

seminar paper? You have learnt in earlier classes how to

insert pictures. Try to insert pictures in the same manner.

You can use the Image tool in the Tool bar for inserting

pictures (Pic 2.5).

Did you face any difficulty when you tried to insert

pictures in this manner? What was it?

Pic. 2.4  A portion of ICT textbook

♦ Size of the picture is not suitable for the page.

♦ When pictures are inserted the position of the words
and sentences change.

♦ ...........................................................................................................................

How can we overcome such difficulties?

Pic. 2.5 - Word Processor toolbar

How can I set the
text in columns?
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♦ Select the picture and bring the mouse and click on

the squares that you see around the picture. Now,

click and drag the mouse to adjust the size according

to your requirement.

♦ To move the picture to the required position, click on

the picture and drag the mouse.

While inserting a picture, some words or sentences

may get displaced. This can be rectified using the Wrap

tool. For this, right click on the picture and select a suitable

Wrap style from the Wrap menu.  If you wish to place

pictures between words, it is preferable to choose Page

Wrap or Optimal Page Wrap options.

You may have to include information related to the
seminar topic in a tabular format in your document. How
will you insert a table?

Activity 2.7 Let’s insert a table

You can use the Insert Table tool in the Tool bar (Pic.
2.5). Click on the Insert Table tool and provide the
required number of rows and columns. Now, haven’t you
inserted the table? (You can also insert a table in the order
Table →→→→→ Insert Table.) But, you will find that in the table
you have inserted, all the cells are of the same size. How
can we format the cell size according to our need?

To adjust the width of the column,

♦ Bring the mouse pointer to the point where two
columns meet.

♦ The mouse pointer changes to a two sided arrow
(Pic. 2.6).

Pic  2.6 Adjusting column space

Adjusting the size of
the picture

Select the picture and
bring the mouse pointer
to the squares you see
around the picture. Click
on the mouse and drag it.
On doing this, the height
and width of the picture
is proportionately
changed. If you want to
change only the height or
the width, press and hold
the shift key. Then, click
on the squares and drag
the mouse as required.
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Now, try to adjust the height of the row in the same
manner.

Shall we merge the cells at the top of each column in
the table we have prepared and type the title in it? At
times, we may have to merge more than one row or
column and add information in it. How can we do it? We
can use the Merge Cells tool for this purpose. Select the
cells which we wish to merge and click on Merge Cells in
the Table menu. You will find that all the selected cells
have merged together. Now, you can type the title there.

Now, you can insert tables, according to your
requirement, in your seminar paper. You may have to
add more rows and columns in the table that you have
inserted. Do you know how to insert rows and columns
in the table?

Follow the steps to insert new columns,

♦ Click either to the left or right of the active cell. Select
Table →→→→→ Insert →→→→→ Columns.

♦ The number of columns to be inserted and its position,
whether to the left or right of the selected cell can be
entered here.

♦ Then, click on the OK button.

Now, you have inserted new columns. In the same
way, new rows can also be inserted and the matter can be
typed in it.

The seminar paper is now ready. Now, don’t you
want to take a print of it?

 Your teacher has suggested that the print out can
be taken from a computer centre in front of the school.
But you found it difficult to open the file in the system of
the computer centre. How can this problem be solved? If
you export the file in the PDF format you will be able to
open it in any system that has the PDF viewer.  How can
we change the document into pdf format?

♦ Click and drag the mouse and adjust the width as
required.

How can I insert
new columns and
rows in the table?
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Activity 2.8 - Let’s convert and export as PDF

♦ Click on Export as PDF in File menu.

♦ In the Range tab, from the window that opens select
whether you want to convert all the pages into PDF
(All) or only a few pages.

♦ Click on Export button.

♦ Select the place where you wish to save the file. Name
the file and save it.

Try to open the file in other computers. Can you open
it? Now, you can take the print out of the document and
present it at the seminar.

The learner:

♦ provides borders, background colour, etc. to a page in the word processor and

makes it look more attractive.

♦ adjusts the page margin, paper size, paper orientation, etc. in a suitable manner.

♦ inserts header and footer and provides page numbers.

♦ arranges the information in columns.

♦ inserts pictures and adjusts its size and position.

♦ inserts tables and adjusts the column width, row height, etc., merges more than one

cell and adds new columns and rows.

♦ exports the file prepared in the word processor to PDF format.

Let’s evaluate

Significant learning outcomes

1. Identify the features of the terms given below and match them.

a)  x3 + y3 Header

b)  Insert Page Number Subscript

c)  HNO
3

Superscript
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2. Prepare a show card in the word processor including the mathematical equations
(a+b)2  = a2+2ab+b2, (a-b)2 = a2-2ab+b2 to be exhibited at the Mathematics corner of
your school. Make it very attractive by giving page borders and background colour.

3. You have to insert the author’s name at the bottom of all the pages of an article
prepared in the word processor. Which of the following tools is the most suitable
for this?

a)  Footer b) Merge Cells c) Insert Rows d) Header

4. Prepare in the word processor a notice for the inauguration of the school IT Club
and save it.

5. You have to merge the first three columns of a table in a file prepared in the word
processor and type a title in it. Which of the following tools can be used for this
purpose?

a)  Delete Cells b) Merge Cells

c)  Insert Columns d) Delete Columns

♦ Prepare a show card in the word processor including the equations of motion
mentioned in your Physics textbook. Increase the font size, provide attractive colours
and save it.

♦ Prepare autobiographical sketches of scientists like Plato, Democritus, Aristotle,
etc. mentioned in your Chemistry textbook in the word processor. Download the
necessary information and pictures from the internet.

♦ Create a table in the word processor that includes the atomic number, number of
electrons, and electronic configuration of elements with atomic number 1 to 18.

♦ Prepare a digital magazine in the word processor including the works of your
classmates. Make the magazine attractive by inserting pictures, providing
background colours, page borders, etc. Insert the name of the magazine as header
and page number as footer.  Save it as PDF.

Follow-up activities
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How can we help Amina?

We know that today almost all the activities of the

service sectors are Internet oriented. Today e-mail or

electronic mail address has become a necessity for all

online services. The following activity will help us to get

to know in detail how e-mail address is created and how

e-mails are sent.

Chapter 3Chapter 3Chapter 3Chapter 3Chapter 3

Amina and her friends of the science club of the school are preparing for a programme

‘A Day to Remember our Heart’ to be held in the school in connection with the World

Heart Day. They have to mail the details of the programme to an eminent cardiologist

who has agreed to deliver the keynote address. Being the Secretary of the club, Amina

is given the responsibility of sending the mail. But she does not have an email address.

How can we

send e-mails?

First we shall create

an e-mail address.

The Infinite World Within Our Grasp
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What all preparations are to be made for sending an

e-mail?

♦ The Internet facility should be available.

♦ Both the sender and receiver should have an e-mail

address.

Activity 3.1 - Let’s create an e-mail address

Let’s see how an e-mail account is created in Gmail.

♦ Open the website www.gmail.com using a web

browser.

♦ Click on Create an Account on the page that appears.

♦ Provide the necessary information in the online

application that appears on the screen (Pic 3.1).

♦ Agree to the terms of service and privacy policy of

the service provider given at the bottom of the page.

♦ Click on the Next step button.

Now, you have obtained an e-mail address.

Open your e-mail account with the e-mail address and

password that you have created.

E-mail

E-mail is the short form of Electronic mail. It is the method of sending and receiving

messages through internet using the electronic media. In addition to messages, we

can also send and receive pictures, audio files, films, etc. through this. There are

service providers who provide e-mail facility free of cost. For e.g. Gmail, Yahoo

mail, Rediff mail. Messages sent through e-mail from anywhere in the world is

stored in the e-mail address of the receiver. You can open the mail using a password

and read the letters and other attached files from anywhere with the help of an

Internet connection.
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Pic. 3.1 Online application form

♦ When you open your account, the inbox of Gmail

appears first. In this, you will find the mails sent by

Gmail welcoming you. You can click on it to open

and read the message.

When you create an

e-mail account...

If the e-mail address that

you wish to create is

already being used by

someone, you will not

get that address. Then,

you will have to make

changes and give a new

address.

An e-mail address has

two parts – name given

by the user (user name)

and the name of the

service provider. The

two names are separated

by the symbol @.

For example: If a person

named Joy Cheeran

registers in Gmail with

the id ‘joycheeran’, his e-

mail address will be

joycheeran@gmail.com

and if he registers in

yahoo.in, his address will

be joycheeran@yahoo.in.

A person with the e-mail

address of a particular

service provider can

send to and receive mails

from the mail address of

any other service

provider.
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You have obtained the e-mail address. Now, let’s see

how an e-mail can be sent.

Activity 3 .2 - Let’s send an e-mail

♦ Click on Compose button in the e-mail window.

♦ Type the receiver’s e-mail address, subject and the

detailed content in their respective columns in the

window that opens.

♦ Click on Send button. You will receive a message that

your mail has been sent.

There may be differences in the arrangement of the

facilities and buttons in the e-mail box of various service

providers. You may examine and find out.

Activity 3.3 Let’s send a copy of the invitation

If you have to send a copy of the notice to the chief

guest, with details of the programme you intend to

organise in the school in connection with the World Heart

Day, what will you do? We can attach the notice to the e-

mail and send it.

To do this you need a digital or scanned copy of the

notice in your computer.

When you enter the
e-mail address…

Type the e-mail address of

the person/persons to

whom you wish to send the

mail in the column labelled

To. If you have to enter

more than one e-mail

address, use a comma to

separate the addresses. If

you want to send a copy of

the e-mail to another

person, enter their e-mail

address in the Cc column

(Carbon Copy). If you

want to send a copy of the

mail to another person

without the knowledge of

the e-mail recipients in the

To and Cc column, enter

the person’s e-mail address

in the Bcc column (Blind

carbon copy).

CAPTCHA

You might have noticed certain letters and numbers

that you were asked to type in a space, as shown in

Pic. 3.2, while providing your personal details to

register for an e-mail address. This is called

Completely Automated Public Turing Test to tell

Computers and Humans Apart (CAPTCHA). It is a test

to ensure that the user is a Human Being. Websites

generally use CAPTCHA to protect the site from

automated programs that are used to hack the websites.

Pic. 3.2 CAPTCHA
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♦ Click on the attachment tool in the Compose window

(Pic 3.3). Follow the instructions that appear to select

the files to be sent and attach them.

♦ Click on the Send button after you have attached the

files.

In the same manner, we can attach pictures, videos,
audio files, etc. along with the e-mail and send them.

Activity 3.4 Various modes of communication

You have learnt the importance and advantages of

e-mail. Now let’s compare the merits and limitations of

various modes of communication (Table 3.1).

Not only service providers but also organizations and

government departments provide free e-mail facility for

official purposes.

For example the e-mail address of IT@School Project

is contact@itschool.gov.in

Pic. 3.3 Mail attachment tool

Use of e-mail: Certain precautions...

♦ Password is the key to enter an e-mail box. Hence, it is safer to create a password

that contains capital letters, small letters, numerals and symbols.

♦ It is good to change your password at intervals to keep your e-mail safe.

♦ Sign out/log out of your mail account after you finish using it.

♦ If you receive mails, attachments, etc. from unknown or unfamiliar addresses,

you should open or respond to it only after ensuring its credibility.

♦ Sending mails which include news, pictures or videos that are false, obscene,

cause defamation to people, or is a threat to national security, is a punishable

offence.
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Mode of communication Merits Limitations

Letter

Telephone

Mobile phone

E-mail

Information can be
exchanged in the form of

text and picture.

Causes delay

Information can be
exchanged in the form of

sound.

Transmission of
message happens very

quickly.

You have learnt how information can be collected
from the Internet and how e-mails can be sent. Almost
any information that we need like those related to literary
works, audios, videos, maps, etc. are available on the
Internet. Among the available versions of the online
encyclopedia, the more trustworthy and comprehensive
information is provided in Wikipedia.

You have already learnt the history and mode of the

functioning of Wikipedia in your previous class.

Wikipedia has many sister projects like Wikisource

(http://ml.wikisource.org), Wiktionary (http://ml.

wiktionary.org), Wikiquotes for quotations ((http://ml.

wikiquote.org), Wikicommons (https://commons.

wikimedia.org), etc. Like Wikipedia, OpenStreetMap is

also a digital map that can be edited freely by anyone.

School Wiki

School Wiki (http://schoolwiki.in) is an

encyclopedia developed using Wiki software that

includes all details like history, location, etc. of schools

in Kerala. Giving information is as important as receiving

information. All these information about schools have

been contributed to this site by groups comprising

students, teachers and old students (alumni). Wiki

Table 3.1  Various modes of communication

Ray Tomlinson
(1941-2016)

Ray Tomlinson was an
American Computer
Programmer who
developed the program
to send messages from
one computer to another
for ARPANET, which
was a precursor of
Internet. He was the one
who selected the symbol
@ to separate the
username from the name
of the service provider in
the e-mail address. Even
now user@host is
considered as the
standard for e-mail
address.
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services have been developed in such a way that any

person can access the site, modify and add information

to it.

Wiki Projects/Services are a treasure trove of

regional knowledge. The information included in the site

is contributed by its volunteers. Depending on the

number of volunteers, the quantity of information

available in the collection may vary. Any person can

contribute to Wiki by either providing information or

editing the contents. People from all over the world and

all walks of life are volunteers in Wiki projects like

Wikipedia.

The fact that anyone, without much technical

knowledge can contribute or modify information,

makes Wiki projects more acceptable to all. You can

include details about your school, other interesting

features of your locality and also articles prepared by

children in School Wiki.

The following information can be included in the

page Ente Naadu in the info box of the school page in

School Wiki (http://schoolwiki.in).

♦ Geographical features of the locality.

♦ Natural beauty of the region

♦ Major job sectors

♦ Statistical data, tables and diagrams

♦ Historical facts

♦ Institutions and organizations

♦ Eminent people and their contributions

♦ Developmental hallmarks and possibilities

♦ Heritage and tradition

♦ Art forms

♦ Language/dialect variations

Let us try to include this information in your School

Wiki page?

Wikipedia exhorts people

to ‘imagine a world in

which every single person

on the planet is given free

access to the sum of all

human knowledge’.

Content/information is

included in the wiki

projects through a

collaborative effort.

Wikipedia operates on

the basis of certain

policies and guidelines.

This lends clarity and

helps to bring consensus

when there are

differences of opinion.

� Wikipedia should

have a neutral point

of view.

� Anyone can edit and

modify the content in

Wikipedia.

� Even though Wikipedia

has certain codes of

conduct, they are not

compulsory laws.

Let’s build the pillars
of knowledge
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Pic 3.5 Interface of a School Wiki page

Anyone is permitted to edit the contents in school

wiki, but only those with membership have the

permission to edit the secure pages and add new

articles. Moreover, your contributions are saved

either in your name or in your username. Your

services to Wiki are evaluated on the basis of the

contributions made and the pages edited using your

username. To get a membership, click on the link

Create an account on the main page. Type your

username, password and captcha and click on the

Enter button. Now, you will get the membership.

As soon as you have the membership, you can see

your username written in red at the top of the wiki

page. Click on the red link to include your personal/group details.

To be a member of School Wiki…

Create membership in School Wiki

Activity 3.5 Souvenir of Ente Naadu in School Wiki

♦ Login to School Wiki (http://schoolwiki.in) and click
on in the order, District, Education District and School

to reach your school page.

♦ Open the link Ente Naadu from the info box of your

school page (Pic. 3.5).
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Pic. 3.5 The part of your school info box

♦ Click on Edit seen at the top of the

page. Provide the information you

have collected and click on Save.

♦ The information required to organize

your article can be seen on the Help

page of Wiki.

♦ Wiki pages are written in a simple

way. Hence, anyone can become part

of this.

Wikiquotes

You have learnt the poem

Viswam Deepamayam written by

Ulloor S. Parameswara Iyer  given

in your Malayalam textbook. Don’t you

remember the last lines of the poem?

a\ n¬ ss\cmiysagp∂h∂p

a[ym”hpw {]Xyla¿[cm{Xw;

ip`w {]Xo£n∏ht\Xp cmhpw

kqcymwipZo]vXw ]I¬t]mseXs∂

-˛ I¬∏imJn

         (\hbptKmZbw)

hnf°p ssIhiap≈hs\ßpw hnizw Zo]abw

sh◊ a\ n¬ hnfßn\ `{Z\p tat∑earXabw

                            (t{]akwKoXw)

The wiki projects which contain a collection of such

famous quotations, inspirational lines of poetry, proverbs,

riddles, idioms, etc. are the Wikiquotes.

Collect such materials from your textbook or from

the library and include it in Wikiquotes.
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Activity 3.6 - Let’s add contents in Wikiquotes

♦               Type the URL http://ml.wikiquote.org in the web

browser and press Enter.

♦ Login and type in the search box, the name of the

person/poet whose lines/poem you wish to add in

Wikiquotes.

♦ If these writers are already included in ‘Wikiquotes’,

the page consisting their quotations will open on the

screen.

♦ If the quotations or lines of a poem of a particular

writer is added for the first time, then a blank page

with the person’s name will open on the screen.

♦ Click on the Edit button that appears on the top of the

page. Now, add the portions that we wish to include

and save it. There is a facility to see a preview before

you save.

Do you know that you are free to use the content of

the Wiki projects without any payment. When you reuse

certain pictures or other materials from wiki, you must

remember to give due credit to the photographer/writer

as mentioned in the copyright license.

Creative use of the social media

Social media has many useful applications. Through

Twitter, Facebook, WhatsApp, etc. and other online media,

we get to know the latest news and day to day events

around the world. Using the Facebook page of your

school, you can share information about your school with

more people. It enables you to share your own views and

have social interactions with others. You can follow the

pages of famous people like writers, artists, scientists and

organisations like NASA, ISRO, etc. through these social

media. There will be a lot of informative details in their

blogs or posts too.

Creative Commons

Creative works like
photographs, music and
literature can be
exchanged or
republished subject to
the Copyright Laws.
Often, complicated
copyright laws have
caused prolonged legal
battles. Creative
Commons is an
organization that works
to increase the
availability of creative
works that can be legally
shared. The organization
has released several
copyright licenses. As
these licenses are more
democratic and popular
than many other
copyright licenses, the
Creative Commons
License is the most
acceptable one for all
Wiki projects.
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Cyber crimes

We have studied about cyber crimes in Standard VIII. Illegal activities or

offences that are committed with the help of modern telecommunication networks

such as computers, mobile phones, Internet, etc. are termed as cyber crimes.

Exchanging or spreading messages, pictures or fake messages with an aim of

disturbing the privacy of a person, trying to defame a person or to threaten the

national security, through internet or any other social media, are grievous

cybercrimes.

Cracking: A malicious act of breaking into a computer or a computer network with

wrong intentions and tampering with the information in it is called Cracking.

Hacking, which examines the operating system or the software deeply and makes

drastic changes in them is often wrongly referred as Cracking.

Phishing: It is an attempt to acquire sensitive personal information like password

details, credit card details, etc.  from a person through fake means.

Cybersquatting: It is an act of registering and using deceptive websites and address

by pretending to be the official websites.

Pornography: It is an act of exchanging, exhibiting and trading obscene contents

with pictures and videos.

Cyber Terrorism: The act of using cyber technology to threaten the security, unity

and supremacy of a nation.

Cyber Laws

The cyber law that came into effect in India on October 17, 2000 is the IT Act 2000.

This law was later amended in October 27, 2009.

This law gives an exhaustive account of the penalties and punishment to be imposed

for cyber crimes. The law is available in the link http://deity.gov.in/content/cyber-

laws.

Emoji

Small pictures or icons (smiley) used to express emotions

commonly used in the social media and other online

communication facilities are known as Emoji. Be it happiness or

sorrow, tiny smiley like faces are used today in online to express

these emotions. Emojis convey our message more easily than a

text. There are all types of pictures in emojis.
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The learner:

♦ creates e-mail address.

♦ sends and receives mails through e-mail.

♦ sends videos and pictures through e-mail.

♦ adds content in wiki projects.

♦ prepares a note on the points to be taken care of while using internet.

♦ gains awareness about cyber laws.

1. In the e-mail address alappuzha@yahoo.co.in, what is the name of the service
provider?

2. The encyclopedia which was developed using wiki software that includes details
like history, location, etc. of schools in Kerala is:

a. Wikipedia    b. Wikisource      c.  School Wiki      d. Wikimedia Commons

3. The act of breaking into a computer or a computer network and destroying the
information in it is called -

a. Phishing       b. Cracking       c. Cybersquatting      d. Cyber terrorism.

♦ Collect information about various e-mail service providers and write a note about
the additional services provided by them.

♦ Collect information about various Wiki projects and conduct a seminar on behalf
of the school IT club.

♦ In the Vidyarangam Kalasahityavedi page of School wiki, include your creative
writing by categorising them as stories, poetry, articles, etc.  Add pictures and make
it more attractive.

♦ Collect quotations, inspirational lines from poems, proverbs, riddles, idioms, etc.
from your textbook or from your school library and include them in Wikiquotes.

Significant learning outcomes

Follow-up activities

Let’s evaluate
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Like the robots, all software that you are familiar with

run on the basis of prior instructions given to them.

Don’t you remember how you prepared computer

games using scratch software in Standard VIII? In the

scratch software, various blocks were used to control

sprites. Did you realise that you were working on a

program that contained special instructions to move the

sprite while using each block?

So, we can conclude that a set of instructions

(programs) helps in the functioning of each software.

Let’s learn how such programs are prepared.

Chapter 4Chapter 4Chapter 4Chapter 4Chapter 4

Programs

The set of instructions
that are given to the
computer is called a
program. The software
such as Gimp, Open
Office Writer, Calc,
Impress that you are
familiar with, have been
prepared in various
programming languages.

Hello Robot, how
do you perform all

these functions?

I am not able to think.
I just carry out the

instructions that are given to
me, that’s all...!

Programming
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Programming languages

Can a computer understand all the instructions that
you give it directly?

The language that a computer understands is the
binary language.

Binary is a language that uses the two symbols 0 & 1 only, for
giving instructions.

Basically, a computer is an electronic machine. A
machine can understand only the presence and absence
of electricity. The presence of electricity is indicated with
1 and its absence is indicated with 0. The presence and
absence of electric pulses can be marked in the machine
using binary language. Therefore, binary language is also
called a machine language.

But it is not easy to prepare instructions in the binary

language. Assume that a program spread over a number

of pages consists of only 0 and 1. Also imagine a situation

where this program needs to be corrected. Obviously it

will be a headache, right? That is how many popular and

easily comprehensible programming languages were

formulated. Python is such a programming language. C,

C++, Java, etc. are some other programming languages.

Algorithm

While giving instructions
to a computer regarding
a particular function,
these instructions should
be arranged as minor sets
of activities. This is
called Algorithm which
is a step by step mode of
instruction given for
solving a problem.

If the computer understands
only the binary language,
don’t you think that we
should convert all the

instructions to this
language?

You’re right. Isn’t it
very difficult?
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But, how does the computer understand these
instructions?

The computer understands the instructions in these
programming languages with the help of a translator
program. See the picture given below (Pic. 4.1).

Pic. 4.1 Illustration of translator program

In each programming language there will be a

translator program that suits its instructions. This program

will take care of converting the instructions to the machine

language. But this translator program should be given

only those instructions that can be converted to machine

language. These instructions and the respective translator

program will be different for each programming

language.

Now, let’s get to know how a program is prepared

in Python language.

Activity 4.1 – Print statement

Let’s try to prepare a program statement to display

your name in Python language.

print(“Amina”)

In this program, “print” is the instruction in Python

for displaying the name, and the word in quotes is the

word to be displayed.

Try to perform the process given overleaf to run this

program.

Python

Python is a very simple
programming language.
It has a simple syntax that
can be easily understood.
It uses very few symbols,
compared to programs
such as Java, C, etc.
Python was designed
under the leadership of
Guido van Rossum. This
software has Open
Source License. Many
software such as Blender
and Openshot Video
Editor, etc. have been
prepared in Python
language.

Translator programs

Translator programs are
used to convert the
programming language
to binary language and
to convert the
instructions in binary
language to the
programming language.



90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

Programming

45Information and Communications Technology - IX

♦ Open IDLE3 from the Programming menu. The
Python Shell window will be opened.

♦ Type print(“Amina”) in Shell Prompter and press the
Enter key.

♦ Don’t you get the output in the Python Shell window
itself? (Pic. 4.2)

Pic. 4.2 Python Shell window

Here, “Amina” is an English word, isn’t it? This is not
included in the word-list of the program. Such words
are called strings. You must have understood that to
display the strings, they should be given in quotes
along with the print statement.

Integrated Development Environment (IDE )

Text Editors can be used to write Python program codes. A program that is thus
written and saved, can be run using a Terminal. For example, suppose a file that
contains a Python program has been saved as pgm1.py in your folder. In order to run
this program we need to open a Terminal from your folder and type python3
pgm1.py and then press Enter.

But there are several integrated software that help you to write and run programs.
They are called Integrated Development Environment (IDE ). IDLE is a simple IDE
software. In Python 2 and Python 3 versions of Python, there are slight variations in
the word arrangement structure. In this unit, Python 3 is referred. We can use IDLE3
version for this.
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Let’s learn more programs

Activity 4.3 - Let’s find the area

Imagine that you need to find the total area of the
playground in your school. You have found the length
and breadth of the playground. What should be done to
find its area?

Shall we give instructions for this to the computer?

Suppose the length is 80 m and breadth is 60 m.

Don’t you want to find the area?

If the variable l (length) is considered as length and the
variable b (breadth) is considered as breadth, we can
consider l = 80 and b = 60.

If we indicate the area with the variable A , then A = l*b.

Now, let’s display A.

How can we write this as a Python program?

l=80 # length = 80

b=60 # breadth = 60

Activity 4.2 – Practise program functioning in Python
Shell

Type each statement given below in Python Shell
and complete the table after observing the output.

Strings

A group of words,
letters, digits or symbols
can be called strings.
Anything that is given in
quotes (even if they are
digits), will be
considered as strings.

Variables can be used to
collect data. Variables
can be indicated using
either letters or words.
Numbers and strings
can be taken as values
for variables.

Variables

 Program statement Output

 print(“Welcome”) Welcome

print(“123”)

print(8+9)

print(“8”+“9”)

print(123)
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Don’t you wish to run the Python codes that you have

prepared?

We can run this program by selecting Run Module from

the Run menu. The output of this function can be obtained

from the Python Shell window. Run this program once again.

What answer do you get? You will get the same answer even

if you run this program many times. What is the reason for

this?

A=I*b # area = length x breadth

print(A) # display value of A

Run each statement of this program in Python Shell.

Don’t you think that it is difficult to run everything
at one stretch?

Shall we create a new file and run this program?

Open a new file from Python Shell window (File →→→→→
New File). Type the program in the window that opens
(Pic. 4.3) and save it in your folder. While saving give a
suitable name to the file.

Pic. 4.3 Window for typing Python program

File extension

The extension of Python
files is .py. When Python
files are stored in IDLE
software they get saved
with a .py extension.

Comment

The comment for each
statement in Python
program can be added
after # symbol. The
comments that are added
in the same row after #
symbol will not be
considered while
running the programme.

Don’t forget to include
such comments in the
programs you prepare.

The length of the
playground in
my school is

100m. Its
breadth is 60m.

There is a
playground near

my house. Its
length is 50 m
and breadth is

40 m.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

48

Programming

Information and Communications Technology - IX

If you wish to find the area giving different
measurements, with the help of this program, what are
the changes to be effected?

♦ The value for length (l) and breadth (b) should be
given.

The Python instruction that is given for this is
eval(input()).

♦ Try to run this program.

l=eval(input())

b=eval(input())

A=l*b

print(A)

Give different values to l and b while you run the
program and press Enter. Don’t you get different values
for the area, with change in the measurements for length
and breadth?

But here, the person who works on this program does
not have any clues as to what measurements should be
given as input or what result should be obtained as
output.

We can give the hint for this along with the input
statement and the print statement while writing the
program. Take a look at how the program has been written
after effecting the changes detailed above.

l=eval(input(“Enter length of the rectangle:”))

b=eval(input(“Enter breadth of the rectangle:”))

A=l*b

print(“Area of the rectangle=”,A)

What changes can you observe while working with
this program compared to what was written earlier?

Interpreter and
Compiler

There are mainly two
types of translator
programs called
Interpreter and Compiler
which are used to convert
the instructions in the
programming language
into machine language.
Interpreter converts each
statement in the program
into machine language.
But in Compiler the
whole program is
changed into machine
language.
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Activity 4.4 - Let’s combine strings

Let’s try to create a program which tells that you are

a student of your school if you give the name of the

school. If string is the value that should be given while

the program is running, give input() in the place of

eval(input()).

s=input(“Enter your School’s name:”)

print(“You are a student of”,s)

Activity 4.5 - Use of mathematical exercise

Prepare a program that gives the sum total of the

angles of a polygon if the sides of a polygon are given.

Suppose assigning the name of the polygon is in

variable “a” and the number of the sides is in variable

“n”, then,

The sum total of the angles is s = (n-2)* 180. This has

to be found out and the value should be displayed.

a=input(“Enter the name of polygon:”)

n=eval(input(“Enter number of sides:”))

s=(n-2)*180

print(“Sum of angles of “,a,” is “,s)

You have practised the use of strings and finding

solutions to mathematical problems using Python

program. There may be several situations in which you

have to take different decisions by examining a value.

Let’s perform an activity in which we can handle such

situations.

Activity 4.6 – Examining the score

Prepare a program that helps you know whether you

got selected for the district level competition, when you

enter your score for the school level quiz competition.

(Imagine that only those who scored above 80 are eligible

for the district level competition).

Combining strings

While displaying more
than one string using
print statement and
while displaying the
strings and the value of
the variables together,
the strings and the
variables should be
separated using comma.
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Pic. 4.4 Program using if..else statement

What all instructions should be given for

this?

♦ The score that is given while running the
program should be considered as a
variable. (Imagine a as the variable). For
this the statement eval(input()) can be used
for this.

♦ Examine whether you have scored above
80. To check whether a statement is
correct, a conditional statement can be
used in programs. Here, using the
conditional statement if you can examine
whether a>80.

♦ When this statement is correct,
“Congratulations, You are Selected” will
be displayed.

How will the program be?

a=eval(input(“Enter your score:”))

if a>80:

        print(“Congratulations, You are Selected”)

What happens if the score given is 80 or below when
the program is running?

Nothing is displayed as output, right?

 That is, if the statement that you examine is incorrect,
you will not get an output. Therefore, this can be
expanded to an if…else statement.

When the statement is correct, “Congratulations, You
are Selected” should be displayed and when the statement
is incorrect, “Sorry, You are not Selected” should be
displayed.

a=eval(input(“Enter your score:”))

if a>80:

     print (“Congratulations, You are Selected”)

else:

    print(“Sorry, You are not Selected”)

You have learnt how different values are given to
different variables. Now, let’s familiarise ourselves with
the Python statement to indicate a group of values.

Conditional Statement if…else

The conditional statement if…else
can be used to check whether a
statement is right or not and instruct
what should be done if the statement
is correct and what should be done if
the statement is not correct. Take a
look at the indent for the statements
used after if, else.
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Activity 4.7 - Find the numbers using the range instruc-
tions

Attempt writing down the numbers denoted while using
the following range instructions.

Instructions Denoted numbers

range (3, 100, 5) 3, 8, 13, 18, 23, 28.............................83, 88, 93, 98

range (0, 50, 10)

range (50, 0, -10)

range (2, 20)

range (15)

These instructions can be typed in Python Shell and

you can find the numbers that are denoted if you run the

programme.

While running Python Shell instead of range(),

indicate list(range()).

Don’t you want to check whether your answer is right

or not?

You are now familiar with the range() statement that

indicates a group of numbers. Let’s learn how range() is

used in situations where one or more actions are repeated.

range

In Python language (range()) is used to indicate a group of values.

range(10) indicates 10 numbers lesser than 10. Here, the starting number is 0 and 1 is
considered as the increase. Therefore, the numbers will be 0, 1, 2, 3, 4, 5, 6, 7, 8, 9.

range (1, 10) indicates 10 numbers lesser than 10, starting from 1. Here, the increase is
1. Therefore, it will be 1, 2, 3, 4, 5, 6, 7, 8, 9.

range (1,20,2) indicates odd numbers that are lesser than 20, starting from 1. Here, the
increase will be 2. Therefore, it will be 1, 3, 5, 7, 9, 11, 13, 15, 17, 19.
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Activity 4.8 - Let’s repeat the activities

You know how to display your name through the
statement print(“Amina”) (Activity 4.1). What instructions
will you give, to display the name 20 times?

As the statement print("Amina") has to be repeated 20
times, it can be included in a loop. So, we can write the
program like this:

for i in range(20):

       print(“Amina”)

Here range(20) indicates 20 values such as (0, 1, 2, 3,
4, 5, 6, 7, 8, 9, 10, 11, 12, 13 14, 15, 16, 17, 18, 19). When the
variable i is given to each value, the statement
print("Amina") starts functioning. Therefore, when ‘i’ is gets
the value 0, the name  Amina is printed. When the next
value is given, (i=1), again the name Amina is printed.
We can conclude that, the name Amina will be printed
when ‘i’ is given any value within the range. Thus the
word is printed 20 times.

Activity 4.9 - Displaying numbers

Suppose you need to create a program to display
the even numbers from 2 to 100.  For indicating the
numbers, you may use the range (2, 101, 2). You can give
different values to variable k and then display.

for k in range(2,101,2):

print(k)

for loops for repeated
instructions

When a statement or a
group of statements need
to be repeated in a
program, it can be
included in a loop. A loop
statement that is used in
Python is called for loop.

Observe the program
given below.

for i in range(1,11):

print(i)

This is a program to
display whole numbers
from 1 to 10.

In for loop the print(i)

statement  runs when the
variable i is given values
1, 2, 3, 4, 5, 6, 7, 8, 9, 10.

That means, the different
values of i is displayed 10
times.

Did you notice the indent
when you used the
repeated statements in
for loop?

While Loop

A loop statement used in Python is called while loop.
When we use while loop instead of for loop, the
statements that indicate the starting value  of the
variable and the increase of the value have to be
indicated separately. Look at how a program in for loop
has been converted to while loop (Table 4.1). What
differences can you see?
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The learner:

♦ prepares simple programs in Python language.

♦ prepares programs in the IDE software called IDLE.

♦ uses print(), eval(input()), input() statements in Python program.

♦ prepares Python programs using conditional statement (if…else).

♦ uses range() statement in Python program.

♦ prepares Python programs using loop statements (for, while).

for loop while loop

for k in range (2, 101, 2):

      print (k)

k = 2

while k<101:

print (k)

k = k + 2

Every time when the value of k is increased by 2, then k = k+2 is used.

Table 4.1  Program in which while loop is used instead of for loop

Let’s evaluate

Significant learning outcomes

1. What will be the output (value of a) of the following program?

a=2

a=a+3

print(a)

a. 5 b. 6 c.  2 d. 3

2. Which among the following is used in Python to indicate numbers from 1 to 20?

a. range(20) b. range(1,20) c. range(1,21) d. range(1,21,2)
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3. for i in range(1,5):

print(“Welcome”)

 How many times will Welcome be displayed in the output of this program?

a. 5 b. 4 c.  2 d. 1

4. a=”3"

b= “2”

print(a+b)

     What will be the output of this program?

a. 5 b. 6 c.  23 d. 32

5. Anu wishes to prepare a program to display the value of numbers from 1 to 25. The
program that Anu prepared is given below. There are some errors in it. Can you
edit the errors?

s=0

for i in range(25):

s=s+i

print(s)

♦ Prepare a Python program to display the multiples of 7 below 200.

♦ Prepare a Python program to find the sum of the even numbers from 2 to 50.

♦ Prepare a Python program to display the multiplication table upto 20 by giving a
number as input.

Follow-up activities
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We live in the wonderful age of information

technology. There has been a great leap in the world of

technology which is an offshoot of the incredible rate at

which the whole world in programming. We can make

use of the various facilities offered by information

technology to make learning and activities related to it,

more effective. Nowadays many educational software are

available in our computer as a scaffold for learning

activities. You are already familiar with learning activities

using different software. In this chapter, you will be

acquainted with some simulation software that helps you

to comprehend and assimilate complex ideas in an easy

manner.

Floating Continents…

Chapter 5Chapter 5Chapter 5Chapter 5Chapter 5

The Practical Lab in Computers
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How was this green earth formed even before the

lizards and dinosaurs reigned over it? Continents and

oceans were formed when lithospheric plates floated on

top of asthenosphere that was partially in liquid form.

You have discussed this phenomenon named Continental

Drift in the chapter titled ‘The Signature of Time’ in your

Social Science textbook. Such natural phenomena can be

carefully studied in detail by using simulation software.

We can observe this with the help of GPlates software

that is included in GNU/Linux by IT@school. GPlates,

which is a Free software has the facility to observe the

formation of tectonic plates over the years, the

reconstruction of tectonic plates and their shifting through

different periods, with the help of simulation.

Activity 5.1 - Formation of continents

Let’s see how continents acquired their present form

through continental drift with the help of GPlates

software.

♦ Open GPlates software.

♦ Open the folder Shapefile in the Gplates Project folder

in Home, through Open Feature Collection in File

Menu. Click Open after selecting all the files (also by

Ctrl+A) in the folder.

You may note that the Layer window also opens

along with the main window (Pic. 5.1).

‘...Long before the lizards, before the dinosaurs, two spores set
out on an incredible journey. They came to a valley bathed in
the placid glow of sunset.
My elder sister, said the little spore to the bigger spore, let us
see what lies beyond’.

The Legends of Khasak
(O.V. Vijayan)

Let me watch the
animation of how

continents are formed.
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♦ Click on Toggle Visibility (sign of an eye) in the Layer

window, you can either show or hide each layer.

♦ If the Layer window is not visible, click on Show

Layers in the Window menu of Main Window.

♦ You can select the Drag Globe tool and freely move

the globe, using the mouse or the Arrow keys.

♦ While using other tools in the Tool Palette, you can

press the Ctrl key in the keyboard and move the globe.

Pic. 5.1 GPlates Main window

GPlates

GPlates software was developed by the scientists in the School of Geosciences in the

University of Sydney as part of their EarthByte Project. Using this software, we can

observe the transfer of the position of tectonic plates in each period, due to continental

drift. The visualisation and analysis of Raster Images in GIS is possible in GPlates.

All the data files in GPlates software are called Features. Such data files that can be

opened through the software are called Feature Collections. When we open the

software we can see a globe that can be turned in any direction any number of times.

GPlates does most of its activities and analysis by including the feature collections

of geological features which were either downloaded or created with the help of this

software.
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♦ To see the geographic plates in different colours, click

on the Triangle on the left side of the layer named

‘Seton_etal_ESR2012_Coastlines_2012.1_Polygon’ in

the Layer Palette and give a tick to the check box

named Fill Polygons.

♦ Click on Configure Text Overlay in View Menu. Then

the Enable Text Overlay window will open. Give a tick

to this window and see the duration of continent

formation. This is measured in Ma (1 Mega Annum=1

million years) unit.

♦ Select Full Screen in Window Menu and run the Play

the animation button.

You have seen the wonderful visual of how various

continents reached their present position after so many

evolutionary stages of coming together and drifting apart,

over the years. Watch the animation once again, keeping

the continents in the globe against you. Seven mega

lithospheric plates which have an area of several thousand

square kilometers and some minor ones like Philippine,

Cocos, Nazca, etc. have been clearly identified. You know

that the drifting of these plates to different directions is

the basis of all major geographical processes. Haven’t you

understood that continents moved apart due to tectonic

pressure and that the modern concepts of nations and

international border were but human constructs?

Let’s save this activity.

♦ Click on Save Project from the File Menu.

♦ Now, name the file and save it in your folder.

The unique file format of GPlates project is gproj.

The projects once saved can be opened through Open

Project in File Menu.

Projection in many
ways

Animation can be viewed
in different projection
forms such as 3D
Orthographic, Rectangular,
Mercator, Mollweide,
Robinson, etc. which are
there in View Control seen
at the bottom of the main
window. You can restore
the window, by a click on
the Leave Full Screen
Mode on top of the
window.

Animation backwards

The continental drift
animation can be viewed
in two ways, i.e. from the
ancient period to the
modern era and vice
versa.  Click on the
Reverse the Animation
option from the
Configure Animation in
the Reconstruction menu.
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Activity 5.2 - Let’s find volcanoes

You know that the boundaries of tectonic plates are

active with volcanoes. We can view volcanic areas with
the help of GPlates.

♦ Use Open Feature Collection to open ‘volcanoes.gpml’
file from the ‘Creating Features’ which is saved in the
Gplatesproject folder in Home. The small yellow
squares that are seen in the globe indicate volcanoes.

♦ To show the boundary of plates in the globe, include
the feature collection ‘Seton_etal_ESR2012_Coastlines
_ 2012.1_Polygon.gpmlz’ from Shapefile folder in the
Gplatesproject folder.

♦ Now, save this in your folder.

Did you understand that volcanoes are found in the
boundaries of tectonic plates? To understand more about
volcanoes and boundaries of plates,

♦ Click on the Feature Inspection tool in the Tool
Palette.

♦ Click on the coastline, volcanoes, etc. on the globe.

♦ Now, you can see their details on Current Feature
which can be seen on the right side of the window

Pic. 5.2 Visualisation of volcano in GPlates

(Pic. 5.2).

♦ Make use of this and prepare an
observation note.

Activity 5.3 - Let’s export GPlates
projects

You may use the export

technique to convert the simulations

in GPlates software to graphic mode.

Let’s see how the ‘Ring of Fire’ area

in the Pacific plate can be exported

in svg format (Pic. 5.3).

Where are
volcanoes mostly

found?
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♦ Open the file that was saved in Activity
5.2.

♦ Arrange the Pacific plate in the globe (Pic.
5.3) in such a way that it faces you.

♦ ‘Ring of Fire’ is an area in Pacific Ocean
which appears like a belt active with
volcanoes.

♦ Click on Export in Reconstruction menu and

then select Export Single Snapshot Instant

from the window that appears.

Pic. 5.4 Add data to Export window

♦ Select Add Export. Click Projected Geometries (and

Rasters) from Choose Data Type. Then, click on SVG in

Choose Output File Format. Give suitable resolution and

name the give the file name in Specify Output Filenames.

Click OK.

♦ Select the folder in which you intend to save the image

from Target Directory and press Export Snapshot. Now,

the image will be saved.

Pic. 5.3  GPlates image of ring of fire

Export in two ways

The visuals that are

viewed in GPlates can be

exported through Export

Time Sequence of

Snapshots and Export

Single Snapshot Instant

methods. Export the

animation in Activity 5.1

using Export Time

Sequence of Snapshots

and save it in your folder.

You will use the images

that you get for slide

presentation, when you

learn about the

presentation software.



90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678The Practical Lab in Computers

61Information and Communications Technology - IX

The learner :

♦ interprets Continental Drift by means of simulation in GPlates software.

♦ prepares a report after locating volcanic areas on the earth with the help of GPlates
software.

♦ finds the ‘Ring of Fire’ area in Pacific Ocean with the help of the software and exports
their image to svg format.

An aid for learning geometry

You have learnt many facts about parallel lines in
your Mathematics textbook. If you wish to confirm these
facts through experiments how many lines will you have
to draw to find out the measurements and their
characteristics? We have studied the GeoGebra software
in the eighth standard which helps to effectively construct
geometric figures and effect some changes in them.  Shall
we use this software to prove certain facts?

Activity 5.4 - Let’s draw parallel lines

♦ Open GeoGebra software and draw the line AB using
Line Tool.

Significant learning outcomes

Let’s evaluate

Follow-up activities

* * * * *

♦ What is the unique file format to save a project in GPlates software?

1) gproj 2) gpml 3) svg 4) png

♦ Include Shapefile feature collection in the software and sequence the Continental
Drift period as 200 Ma. Locate the position of South America and Africa and save it
in svg format.

♦ Include the Feature Collection Working with Mid Ocean Ridge from GPlates Project
Folder and devise the formation of submarine mountain ranges through simulation.
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♦ Mark point C using Point Tool, near to this line (Pic.
5.5).

How can we draw a line through point C, parallel to

the line AB?

♦ Select the Parallel Line tool.

♦ Click on the point C and on line AB.

Give a suitable name to this construction and save it

in your folder.

What will you do if you want to draw another line at

the same distance? How many times would the distance

of this line be from AB? We can draw a line like this at a

particular distance using Dilate from Point tool in

GeoGebra.

Activity 5.5 - Draw a parallel line at a particular distance

It will be two times the distance from A to the line
that passes through C. Let’s do this activity.

♦ Select the Dilate from Point tool. Then, click on the
line through C and on the point A using the tool.

♦ Give 2 as Dilation Factor in the window that appears.

Haven’t you got a new line that you wanted? (Pic.
5.6)

Pic. 5.5  Parallel lines

Various kinds of
Windows

By marking a tick mark
in the View menu of
GeoGebra window, you
can include perspectives
such as:

Algebra View

Graphics View

3D Graphics View

Spreadsheet View

CAS View

according to your wish.
When you click on each
View, the respective
tools will be displayed.

Dilation

Dilation Tool can be
used to increase the size
of an object and its
distance from a point in
a fixed rate. If you click
on the object to be
dilated and the point
that is considered as the
base after selecting the
tool, you will get a
window. If you give the
Dilation Factor which is
the number that indicates
the number of times, the
distance should be
increased and give OK
you will get the new
object in the prescribed
size and distance.
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Now, dilate the line that passes through C three times
and draw another parallel line. What is special about the
four lines that are seen there?

Save the activity in your folder.

Activity 5.6 – Find speciality of parallel lines

Let’s draw a line segment that intersects the four lines
you have constructed. For this,

♦ Mark one point each on the first and the last line using
the Point Tool.

♦ Join them using the Segment Tool as you see in Pic.
5.7.

Don’t the parallel lines intersect this line segment?
You can use the Intersect tool in GeoGebra to find the
points of intersection.

♦ Select the Intersect Tool and click on one of the parallel
lines and the line segment. Didn’t you get the points
of intersection? Mark other points of intersection like
this.

♦ Mark the length of each part using the Distance or
Length tool. Are the lengths equal?

Change the position of the end points of the line
segment using Move tool. What specialties do you notice?
Note them down.

...........................................................................................................................

...........................................................................................................................

...........................................................................................................................

We have learnt how to draw circles of a given size in
the eighth standard. What should be done to adjust the

Pic. 5.6 Parallel lines at a same
distance

Pic. 5.7 A small line that
intersects the parallel lines

Let’s mark the point of intersection

You can mark the points of intersection of two geometric
figures by a click using the Intersect Tool.
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size and shape of a geometrical figure? We can use the
Slider tool in GeoGebra for this.

Pic. 5.8 Window for creating a
Slider

Activity 5.7 - Let’s draw a circle that can be adjusted
using Slider

Suppose you wish to construct a circle of which the
radius can be adjusted from 1 to 5. First of all, you have
to construct a slider for this.

♦ Select the Slider tool and click on the window. A
window will appear as you can see in Pic. 5.8. It is the
radius of the circle that has to be adjusted. For this,
the Number Slider has to be selected. Don’t you notice
the name of this Slider?

♦ Provide values Min: as 1 and Max: as 5 and click on
Apply. The slider will appear.

♦ Click on the window after selecting Circle with Center
and Radius tool. In the window where you have to
provide the value of the radius, provide the name of
the slider you have already constructed.

♦ Move the slider using Move tool. You can observe
that the radius of the circle changes according to the
value of the slider.

Try to give animation to the Slider. What should be
done to see the circles for each value of the slider at the

Let’s make Slider

Slider is a tool in GeoGebra that is used to control the
value of a variable that indicates a number or a
measurement of an angle. Select the Slider Tool and
click on the GeoGebra window. A window like the one
you see in Pic. 5.8 will appear. The values of the Slider
can be arranged as real numbers, measurement of
angles or integers, according to your wish. For this, you
need to press on the radio buttons Number, Angle or
Integer respectively and select any of them. The Slider
will appear when you give the name of the Slider, its
minimum value, maximum value and the rate of
increase and click on the Apply button. You can adjust
the value of the Slider by dragging or using the arrow
keys after selecting.

More software for
learning Mathematics

There are many software
which come under the
group of software like
Interactive Geometry
Software (IGS) and
Dynamic Geometry
Environment (DGE).
Geometric Supposer,
which was formed in the
1980s was the first of this
kind. Drawing Geometry
(Dr. Geo), K Interactive
Geometry (Kig), CaRMetal,
etc. are free software
whereas Cabri Geometry,
Cinderella, etc. are
proprietary software.
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same time? You need to right click on the circle and put a
tick to Trace on.

The learner :

♦ familiarises the tools in GeoGebra software,
establishes geometric theories using them and
documents them.

♦ finds the facts related to geometric figures like
triangle, circle, lines, etc. through the activities in
GeoGebra and documents them.

♦ draws figures using GeoGebra that are helpful for the
learning of Mathematics.

1. Imagine that using the Slider you have drawn a figure in GeoGebra. Which tools
are to be used simultaneously to see the figures having different values in the
Slider all at once?

(a) Zoom In

(b) Trace on

(c) Animation on

(d) Intersect

2. Do the following activities using GeoGebra and save them in your folder after giving
suitable names.

♦ Draw two parallel lines. Find the distance between them and mark them.

Hint: You can use Perpendicular Line, Intersect, Distance or Length tools.

♦ Construct triangle ABC in the given measurement. AB = 5 units, AC = 4 units, BC =
3 units.

Hint: You may use tools viz. Segment with given Length, Circle with Center and
Radius, Intersect, etc.

Let’s give animation

To give animation to
the objects in GeoGebra
window, right click on
them and put a tick
mark to Animation On
in the check box. You
cannot give animation
to all objects.
Animation can be given
to objects that move in
a fixed path. (e.g. A
point on a circle or a
line). If a slider is given
animation, the objects
that are controlled by it
also get animation.

Significant learning outcomes

Let’s evaluate
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Through the Stellar Sights

There is a reference to stars in the unit titled “Our
Universe” in your Physics textbook. We have limitations
to observe the stellar objects that appear in the sky,
including stars. We have a simulation software called
Stellarium that produces a virtual reality of the sky. By
adjusting the location and time in this software, you can
observe the sky from any location at any time. You can
reproduce interesting and wonderful stellar aspects in a
clear and simple manner through Stellarium software.

Activity 5.8 - Let’s use the Stellarium software

♦ Open the Stellarium software.

♦ When you bring the mouse pointer to the left side of
the main window, you get
the Tool bar and when you
bring it to the bottom, the
Status bar will appear
(Pic. 5.9).

♦ By a click on the triangles
that are seen at the place
where the status bar and
tool bar joins, you can fix
them on their respective
places.

* * * * *

Pic. 5.9  Stellarium – Main window

♦ Draw each figure given below using GeoGebra. Select the part that includes the
figure and export them in image format (File-Export).

Follow-up activities
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Activity 5.9 - Let’s adjust the location

The area of sky that is visible to us will be different

when we observe space from various locations. If the area

of the sky from a particular location should be made

visible, the location has to be specified in the software.

For this, follow the activities given below.

You can click on the Location window (F6) tool seen

on the top part of the tool bar.

You can click on the location in the map that appears

in the window that opens and adjust the view of the sky

from there (Pic. 5.10). You can also select from the list of

locations given in the software. If necessary, click on the

Reset Location List.

Pic. 5.10 To adjust the location of observation

Add a new location

We can include places in

the Location window that

are not in the list of places

in Stellarium. Enter the

details of the location

such as latitude,

longitude, the name of

the location and country

in the relevant boxes seen

below the Current

location information (Pic.

5.10). Then, click Add to

list button and close the

window. (no need to

make changes in the

Altitude box).

Adjust day and time

Click on the Date/Time window

(F5) (Pic. 5.9) in the Toolbar to

observe the sky at a particular

time on a particular day. Click

on the Triangular buttons in the

Date and Time window (Pic.

5.11) and change the day and time.

Pic. 5.11  Adjust day and time in the software
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Activity 5.10 - Let’s observe constellations

You have seen a lot of stars in the sky. Stars appear
in the sky as particular groups or constellations. These
constellations are considered by us as imaginary figures.
Let’s see how we can observe such constellations using
Stellarium software.

♦ Open Stellarium software.

♦ Click on Constellation lines (C), Constellation labels
(V) and Constellation art (R) (Pic. 5.12) tools that
appear in the Status bar.

To watch the sky which is boundless, click on

Ground tool in the status bar (Pic. 5.12).

♦ Enter the name of the constellation that you wish to

view and their imaginary shape in your notebook.

Activate Atmosphere tool (Pic. 5.12) in the status bar

to view the space clearly during the daytime.

Suppose you want to see the constellation Leo

(Chingam) through this software. For this,

♦ Click on the Search window (Pic. 5.9) in the tool bar.

♦ Type Leo in the Search box (Pic. 5.13) in the Object

tab that appears and then click on .

♦ Zoom using Page Up, Page Down keys or using the

Scroll button of the mouse.

Pic. 5.12  Stellarium status bar

Pic. 5.13 Stellarium Search
Window
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♦ Observe carefully the Leo constellation (Pic. 5.14) by
dragging the mouse or using the arrow keys in the
keyboard.

♦ Find the name of the star that appears when you click
on each star in constellation Leo and complete Table
5.1.

You know that the sun is the closest star to the earth.

You have learnt that the earth revolves round the sun,

while it rotates by itself. Because of the revolution of the

earth, a person who observes the sun from the earth may

feel that the sun is moving in a particular path. This path

is called an Ecliptic Line. Shall we observe the Ecliptic

Line through Stellarium Software?

Pic. 5.14  Leo (Chingam), the
constellation

Sl. No.           Name of the Star

1 Regulus

2 Denebola

3

4

Table 5.1 - Stars in Leo constellation

Activity 5.11 - Let’s find the ecliptic line

♦ Click on Sky and viewing options window tool
(F4) (Pic. 5.9) in the tool bar in Stellarium
software and reach the View window.

♦ Click on Ecliptic (of date) (Pic. 5.15) in the Celestial
Sphere list of Markings tab and close the window.

♦ Zoom using Page Up and Page Down keys or the
Scroll Button of the mouse.

♦ You can bring the Ecliptic Line in the range of visibility

Pic. 5.15  View window

Names of Stellar
objects in Malayalam

When you select
Malayalam from Sky
Culture Language in the
Main tab of
Configuration Window
(F2) in the tool bar of
Stellarium Software and
close the window, the
names of constellations
will appear in
Malayalam.
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either by dragging the mouse or by using
the arrow keys in the keyboard.

♦ Identify and list the constellations in the
Ecliptic Line using Constellation Lines (C),
Constellation labels (V) and Constellation
art (R) given in the status bar.

The learner :

♦ adds location for observation in Stellarium software.

♦ identifies constellations with the help of software and notes down their
characteristics.

* * * * *

Significant learning outcomes

Let’s evaluate

Follow-up activities

Pic.  5.16 - Ecliptic line

♦ On which tool should you click to display the imaginary form of Orion constellation
in the Stellarium software?

a. Constellation labels b. Constellation art

c. Constellation lines d. Azimuthal grid

♦ Which function helps to fix the Tool bar and the Status bar in the window of
Stellarium software in their respective positions?

a. Click on Ground button.

b. Click on Configuration window.

c. Click on the triangles that you see where Status bar and Tool bar joins.

d. Click on Ocular view button.

♦ Make changes to the time of observation in the software and find the constellation
in which the sun appears in the Ecliptic Line on January 1.

♦ Observe Polaris with the help of the software and find in which constellation it is
found.
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From charcoal to gem brightness

You have learnt in your Chemistry textbook the

phenomenon called allotropy which explains how an

element appears in various physical states. Carbon atoms

combine with each other to become molecules in cyclic

forms or chain forms. In nature, we can see carbon in

different forms from charcoal to diamond. This is because

of the difference in the configuration of atoms in

molecules. Is it possible for us to find how atoms are

configured in molecules? You have practised various

activities in ghemical software on the ways to prepare

models of simple molecules and to observe their three-

dimensional structure in the computer in your eighth

standard. Which are the compounds, the models of which

were constructed by you using ghemical software in your

eighth standard?

♦ Water (H
2
O)

♦ Carbon dioxide (CO
2
)

♦ ...........................................................................................................................

We have done the construction and observation of

molecules with a simple structure. We can observe

molecules with a complex structure using RasMol

software included by IT@school in GNU/Linux.

Diamond, Graphite and Fullerene are the allotropes

of Carbon in crystal form. A lot of carbon atoms are

combined in it. The pdb files of such complex molecules

are available on the internet. Download the pdb files of

Diamond, Graphite and Fullerene with the help of your

teacher and save them in your folder. Files of this kind

can be used for your learning purposes.

Activity 5.12 - Observe the molecular structure of
Fullerene

♦ Open RasMol (GTK version) software.

RasMol

RasMol is a software
developed by Roger Sail
to observe the three
dimensional structure of
molecules (http://
www.rasmol.org). The
three-dimensional form
of molecules will be
shown in different
colours in the graphic
screen of RasMol
software when we give
the basic facts as file
input. Usually extension
files named protein data
bank or .pdb are given as
input.
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♦ Open the pdb file of Fullerene molecule using File →
Open. The Wireframe model of Fullerene molecule
structure will be visible.

♦ To convert this to Ball & Stick model, select and click
on the Ball & stick in the Display menu.

♦ Using the mouse, turn the molecule and observe how
carbon atoms are combined in it.

Suppose you want to find the number of carbon
atoms in a Fullerene molecule. What is the way out?
Follow the process given below.

♦ When the Command prompt (F7) in the View menu is
activated, the Terminal window appears below the
Graphic Screen window.

♦ When you type ‘select carbon’ in the Terminal window
and press the Enter key, the number of carbon atoms
will be shown (Pic. 5.17). Then type ‘color yellow’.
Don’t you see that the carbon atoms turn yellow? What
will you do to give some other colours?

Activity 5.13 - Observe the molecular structure of dia-
mond and graphite

Find out the pdb files of Diamond and Graphite
molecules which are allotropes of Carbon, using RasMol
software and complete Table 5.2.

Pic. 5.17  Molecular structure of
Fullerene

Though only carbon atoms are contained in Diamond
and Graphite, the configuration of atoms in their
molecules are different. This is why their physical
properties appear to be different.

Table 5.2  Difference in the molecular structure of diamond and graphite

Characteristics           Diamond Graphite

Shape of the molecule Three-dimensional network Hexagonal Layer

Combination of
carbon atoms

One atom of carbon
combines with other four
carbon atoms
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The learner:

♦ observes the molecular structure of substances as three-dimensional images.

♦ observes the molecular structure of Fullerene molecule with the help of the software
and finds the number of carbon atoms in it and their molecular shape.

♦ observes the three-dimensional image of allotropes of carbon such as Diamond
and Graphite with the help of software and finds out the reason behind the difference
in their physical properties.

Pic. 5.18 Molecular Structure of diamond and graphite

Follow-up activities

Let’s evaluate

Significant learning outcomes

♦ Which of the following files can be used to observe the molecular structure of a
substance through RasMol software?

a). pdf b). pdb c). png d). ppt

♦ Collect pdb files of various molecules from the internet and observe them using
RasMol software.
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These statements indicate the changes in atmospheric
temperature of recent times. You might have understood
how the change in atmospheric temperature influences
the climatic conditions.

In the lesson ‘Sun: The Ultimate Source’ in your Social
Science textbook, different types of analyses of
temperature in various parts of India is referred to. Anu
and Amina are getting ready to gather information on the
temperature in different parts of India as referred to in
the lesson and analyse them. Anu is of the opinion that
the activity is a bit difficult because a lot of data has to be
handled. It was their teacher who hinted that Spreadsheet
software can be used for analysing data and for arriving
at conclusions.

Chapter 6Chapter 6Chapter 6Chapter 6Chapter 6

Analysing Data in the Computer

Severe drought is in
store for us

Kera
la sw

eats 
in

sc
orc

hing h
eat
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With the help of LibreOffice Calc familiarised in the
eighth standard, let’s help Anu and Amina to do this
activity according to the teacher’s instruction.

For this, they collected the data of the maximum and
minimum temperature in different parts of India from the
Internet. Then, it was tabulated in LibreOffice Calc as  seen
in Pic. 6.1. The table was saved with the name
‘temperature’ in the prescribed folder in Home.

Pic. 6.1 Temperature at different places

Weather information
on the Internet

Information on the daily
weather conditions of all
the important cities in
India are available on the
Internet. We get daily
information from the
official website (http://
imd.gov.in) of the Indian
M e t e o r o l o g i c a l
Department under the
Ministry of Earth
Sciences. The department
is entrusted with the
responsibility of
studying the climatic
changes and giving prior
warnings on natural
disasters.

How do we
do that?

The table of temperatures
is ready. Now, we have to

find out the daily mean
temperature in each place.
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Activity 6.1 - Let’s see the average temperature

Add the title “Daily Mean Temperature” to the first

cell of the column next to Minimum Temperature in the

table that you have saved. You know that you need to

divide the sum of maximum temperature and minimum

temperature by 2, to find the average of any town. You

may remember the way to find the sum. Here, you need

to find the sum of the cells from C2 to D2. Follow the

process given below.

♦ Select the cell in which you intend to get the average
(E2).

♦ Type =SUM(C2:D2)/2 and press Enter key.

(Pic. 6.2)

Now, save the file.

You can also find the average using the
function AVERAGE which is available in
LibreOffice Calc.

Moreover, you may use the functions
for making more complex calculations and
analyses.

Daily Mean
Temperature

Daily Mean Temperature
is the average of the
maximum and the
minimum temperatures
in a locality.

Functions - A scaffolding

Don’t you remember the function SUM you have used to find the sum of numbers?

There are more than 350 functions in LibreOffice Calc to analyse and interpret data.

Based on their usage, these functions are divided into different categories viz.

Mathematical, Statistical, Logical, Financial, etc. You can open the Function Wizard

using the function tool ( ) or by selecting Function from the Insert menu. (Keyboard

shortcut Ctrl + F2). You can select the necessary function from the window and give

information according to the instructions to get correct results.

AVERAGE, ROUND, IF, LOOK UP, COUNT IF, etc. are some of the useful functions.

The user can construct his or her own functions in addition to those that are available.

You can learn more about this in your higher classes.

Pic. 6.2 To find the mean
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How will you find out the average temperature of
other cities? Do you have to repeat the activities that you
have done earlier? Is it possible to do this using Fill handle
that you have learnt earlier?

Select the cell E2 in which you have found the
average temperature and drag the Fill handle (+ sign seen
when the mouse pointer is brought to the right bottom of
a cell) downwards.

ROUND is a function that is available in Calc to
determine the necessary decimal places after retaining
the required digits after a decimal.

Activity 6.2 - Let’s round the decimal places

We can give the title “Daily Mean Temperature

Rounded” to the column (Column F) which is next to

Mean Temperature. Try to do the activities by selecting

the cell (F2) in which the results have to be obtained.

♦ Select the function tool ( ) in the tool bar.

♦ From the window that opens, select ROUND from the

Function list and click Next.

♦ Click on the box number and give the cell address

(here E2) in which the decimal place has to be rounded

(Pic 6.3).

♦ You have to give the number of digits that should be

there after the decimal point in the box called count. As

we don’t need any number after the decimal point here,

we need not give anything (you can also type 0).

Now click on OK and drag the Fill handle in F2.

Do not forget to save the file.

What difference should be brought about in this

activity to show two digits after the decimal point using

the ROUND function?

Pic. 6.3  ROUND function

window

Calculations would
have been easier if
decimal places had

been avoided.
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Activity Function

Find the sum of cells from A1 to A6.

Find the average of the numbers in the

cells from A1 to A6

Round the number in A7 to two decimal

points

Find the average of numbers in the cells

from A1 to A6 as a whole number.

SUM = SUM (A1:A6)

ROUND &

AVERAGE
= ROUND(AVERAGE(A1:A6), 0)

Table 6.1 Functions and Instructions

What should be typed in the cell

Activity 6.3 - Let’s include the functions directly to the
cell

Complete the following table (Table 6.1) by finding
out how to include the necessary functions for the
activities given below.

Is it not possible to categorise the places in the table

as places with warm climate and those with cool climate

on the basis of a fixed norm? Calc has many functions for

categorising the data. Let’s see how the function IF is used

in this category.

When Fill handle is
double clicked

You know that to copy a
function or formula to the
next cell, it is enough that
you drag the Fill handle.
Instead of this you may
double click on the Fill
handle. Does the
formula/ function/
sequence get copied to
the downwards cells? We
can understand that in
certain situations this is
not possible. This can be
possible only if the data
is there in the columns
that precede or succeed
the column in which Fill
handle is used.

Now, we should
categorise the
places on the
basis of the

temperature.

Yes…places which
have a warm climate

and those with a
cool climate, isn’t it?
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Activity 6.4 - ‘IF’ to categorise data

There should be a criterion for categorising the data.

Imagine that you need to categorise places: those with

the average temperature below 250C as Cool Climate and

those above 250C as Warm Climate places. Add the title

Climate in the ‘G’ column which is next to Daily Mean

Temperature Rounded column in the table and try to do

the following activities.

♦ Click on Function tool, after selecting the cell where
you should get the result (G2).

♦ Select IF from the Function list in the Function Wizard
window that opens and click on Next.

♦ In the Test box, fix the average temperature as below
25°C, which is the criterion for categorisation. Using
the cell address you may add as F2 < 25 (Pic. 6.4).

♦ In the Then_value box, you should add what is to be
displayed if the norm is correct. (here ‘Cool Climate’).

♦ In the Otherwise_value box, you should add what is
to be displayed if the norm is incorrect (here ‘Warm
Climate’).

♦ After that click OK and drag the Fill handle in G2.

Now, you may save the file.

Now, Anu had a doubt. If we want to compare the
climate of more than two categories, can we use IF in such
cases.

When you have to categorise the data into three or
more groups, LOOKUP function is more suitable than IF
function.

Activity 6.5 - LOOKUP for categorising data

Let’s fix the criteria for categorising the data just as
we used IF. For example, imagine that you are using the

following method:

Pic. 6.4  IF function window

Let’s include more
sheets

At the bottom left of the
Spreadsheet window, a
label Sheet 1 is indicated.
It means, the table that
includes temperatures is
the first sheet in this file.
You can include more
sheets according to your
need by a click on the +
sign that is seen here. The
Spreadsheet file that
includes more than one
sheet is also called a
Workbook.

In Spreadsheet, facility to
give suitable names to
the sheets is also
available.
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Temperature below 20°C      - Cool Climate

Temperature between 20°C and 30°C - Moderate Climate

Temperature above 30°C       - Hot Climate

Save the table with the name ‘temperature_climate’

using Save As. Delete the data of the last column which

was categorised using IF and try to do the activities as

given below.

♦ Type the criteria either in the sheet of the table or in

any other sheet (Pic. 6.5). This is the LOOKUP chart.

Here LOOKUP chart is typed in Sheet2. (You should

remember that you can include any number of sheets.)

♦ Select the LOOKUP chart wholly and click on Define

Range in the Data menu.

♦ Give a name in the Name box in the window that opens

and click OK. (Here the

name given is ‘climate’)

(Pic. 6.6).

♦ Now, select the cell in

which you want to get

the result in Sheet 1 and

click on the function tool

in the tool bar.

♦ Select LOOKUP from the

Function Wizard

window that opens and click Next.

♦ Give the cell address of the average temperature in

the Search criterion (here F2) box and the name of the

LOOKUP chart (climate) in the box named Search

vector (Pic. 6.7).

♦ There is no need to enter anything in the result_vector

box.

♦ Now, click on OK and drag the Fill handle. Are they

categorised in the desired way? (Pic. 6.8).

There is a facility available in Calc to classify a

particular type of data and make a new table from the

table you have prepared. We use the facility named Auto

Filter for this purpose.

Pic. 6.6  Define Range window

Be careful while using

IF…!

While using IF, do not
forget to type in quotes
(“ “) when you enter the
sentences to be
displayed in the value
boxes. (“Cool Climate”,
“Warm Climate”, etc.)
But if the numbers have
to be entered instead of
sentences, it is not
mandatory. Don’t you
remember Strings and
Numbers that you have
studied in the previous
lessons?

Pic. 6.5  LOOKUP Chart



90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

81

Analysing Data in the Computer

Information and Communications Technology - IX

Pic 6.8  Analyses of temperatures

Activity 6.6 - Let’s classify data

Suppose you want to find places having a daily
average temperature of 25°C. Let’s see how this activity
can be done using Auto Filter.

♦ Select any one of the cells from the title cells.

♦ Click Auto Filter tool in the Tool bar (Pic. 6.9) (Or else
select Filter → Auto Filter from the Data menu).

♦ From the buttons ( ) you see in the cells that have

the titles, click on the button which is close to the data
that has to be classified (here F1).

♦ Retain the tick marks of the necessary data in the
window that opens (here the tick mark of 25 alone
has to be retained) (Pic 6.10).

♦ When you click OK, you will get the table of those
cities that have a daily average temperature of 25°C.

♦ Include a new sheet in the Spreadsheet window and
Copy→ Paste the table that has been filtered. Then,
save the file.

Pic. 6.9 Auto Filter tool

Pic. 6.7 LOOKUP function

window

How can I classify
places which have

the same
temperature in this

table?
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You can filter the data by selecting Standard Filter
in the Auto Filter window by fixing the criteria for
filter. Now, filter the table and using this method, find
out the data in which the average temperature is below
20 °C.

You must also have faced such a problem while
copying the data which was prepared by a function or
formula from the Spreadsheet to another cell/sheet.

We can solve this problem using the facility Paste
Special in LibreOffice Calc.

Activity 6.7 - Paste special

Add a new sheet to the Spreadsheet file. Copy the
names of places including title from the table and paste
them in the first column (Column A) in the new sheet.
Now, follow the process given below in order.

♦ Open the sheet that contains the table and copy the
column in which the climate including the title is
recorded.

♦ Then, select the second column in the new sheet.
Select Paste Special from the Edit menu.

♦ Tick  Text and Numbers only in the window that opens
and click OK (Pic. 6.11).

Pic. 6.10 Auto Filter window

Pic. 6.11 Paste Special window

Oh, when I tried to
copy the names and

climate to a new sheet,
it didn’t work.

You’re right. Only
the names of

places are
correctly copied.
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You may not be able to open the Spreadsheet file
that we saved in the computer that has a different
operating system or office application, or on any other
device. This problem can be solved by converting this
file to pdf format.

Activity 6.8 - Let’s export as PDF

We have learnt in earlier units that files in pdf format
are supported by most of the operating systems. Now,
try to export the Spreadsheet file that you prepared to
pdf format.

Even if we save our Spreadsheet file, it is likely
that others may bring in changes to it. Such corrections
may create difficulty. Let’s see what facility is there in
Calc to solve this without hampering the freedom to open
and see the file.

Activity 6.9 - Let’s protect our file

You can protect your files from unnecessary editing
using the facility Protect Document. Follow the process
given below.

♦ Open the sheet that you want to protect.

♦ Open the Protect Sheet window from the Tools menu
in the order Protect Document → Sheet.

♦ Give a password in the box which demands a
password. Type the password again in the Confirm
box and then click OK.

♦ Save the file.

Now, try to edit the file. Does it work? What if you
need to edit the file again? Try to do it in the same way as
referred to above.

Let’s interchange
rows and columns

If you click Paste Special

while you copy and paste

the data in a row and tick

on Transpose under

Options in the window,

(Pic. 6.11) then, the data

will be arranged in a

column. If you copy

more than one row using

this facility, the rows will

be arranged in the order

as columns.

Online Spreadsheets

We have been discussing
about Spreadsheets that
can be worked by
installing it in the
operating system. But
there are Spreadsheet
applications that can be
used online without
installing, in a computer
that has internet facility.
The major advantage of
online Spreadsheets is
that they support most of
the Spreadsheet formats.
But, online Spreadsheets
can be used only if you
agree to the conditions
specified by the
organisation that provide
them.
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The learner:

prepares Spreadsheet tables using AVERAGE, ROUND and FILTER facilities.

adds new sheets to the Spreadsheet table.

prepares analyses in Spreadsheet table using IF and LOOKUP functions.

pastes data using Paste Special facility.

exports the table in Spreadsheet to PDF format.

protects the sheets in Spreadsheet table from editing.

LOOKUP chart

0 A

10

C

B

D

20

30

♦ A

♦ B

♦ C

♦ D

Let’s evaluate

Significant learning outcomes

1. Which of the following facilities is available if you protect a table in a sheet of Calc
using Protect Document?

♦ The data in the sheet cannot be copied by anyone else.

♦ The data in the sheet cannot be edited by anyone else.

♦ The data in the sheet cannot be seen by anyone else.

♦ The data in the sheet cannot be printed by anyone else.

2. If you categorise the data using the following LOOKUP chart, in which category
will 41 appear?

3. As part of the activities of the School Health Club, find out the weight (in kg) and
height (in m) of all the children in your class. Calculate the BMI (Body Mass Index)
of each child by tabulating the data in LibreOffice Calc.

Hint : BMI = (weight in kg/height in m2)



90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678
90123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678

85

Analysing Data in the Computer

Information and Communications Technology - IX

4. Based on the table of BMI in the previous activity, use LOOKUP function and
categorise the health condition of the children as Under Weight, Normal Weight,
Over Weight and Obesity.

Hint : LOOKUP chart

BMI less than 20 - Under Weight

BMI between 20 and 25 - Normal Weight

BMI between 25 and 30 - Over Weight

BMI 30 and above - Obesity

1. Tabulate the national income of the last three years of some countries using
LibreOffice Calc. Calculate the average national income of each country using
AVERAGE function.

2. Collect data on the population of all states in India and tabulate them in Calc. Using
the Filter facility, categorise only those states which have a population of more
than 8 crore. Add a new sheet and include this table in it. Give the name ‘Highly
Populated States’ to this sheet.

3. Collect data on the consumption of electricity for a period of ten days in the houses
of all your classmates and tabulate them in Calc. Calculate the daily average
consumption of electricity. Filter those houses where the average consumption is
more than 5 units and show them in a separate sheet. Visit these houses and create
awareness on the need to reduce the consumption of electricity.

4. Prepare a Spreadsheet table of School Kalolsavam which shows the grades
according to the given criteria, when the scores given by the judges for various
items are entered.

5. There are many Spreadsheet applications supported by different operating systems.
Collect information regarding them and list them in the following table.

Follow-up activities

Spreadsheet Application Developed by Operating systems that support
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All the pulsations of life on our planet earth are
controlled by the Sun. The very existence of the biosphere
is dependent on solar energy. You might have learnt
about the human deeds which cause the changes in the
atmospheric temperature and also about the need for
protecting the Earth for the coming generation, in the
lesson ‘Sun: The Ultimate Source’ in your Social Science
textbook.

Varsha and Vipin are preparing a presentation in the
computer on the topic ‘Global Warming’ to be presented
at the seminar to be conducted in the school on the World
Environment Day. Can you help them? You are already
familiar with the presentations using LibreOffice. What
are the prerequisites for this?

♦ Fix the content.

“IØp∂ kqcys‚ IÆpIfn¬ \n∂·n

h¿jn®p tcmjapWcp∂p

BSnapIn¬ame IpSn\ocp Xncbp∂p

BXncIƒ Ipfncp Xncbp∂p.”

-- Bhoomikoru Charamageetham
(O N V Kurup)

Chapter 7Chapter 7Chapter 7Chapter 7Chapter 7

Making an Impressive Presentation

We can
prepare the
presentation

using Impress.
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♦ Prepare the storyboard.

♦
...........................................................................................................................

♦
...........................................................................................................................

You know how to prepare a good storyboard, don’t
you? Now, you have to collect information, pictures and
videos required for a presentation. From where can you
collect these?

You can gather information from various content
CDs, Internet, other digital collections, etc. You can gather
information and store them in a separate folder.

You can start preparing slides, if you have completed
the arrangements. For this, open LibreOffice and type the
content in it. You were taught in the previous class to
give the appropriate background colour to the slides. So
you can give background colour to the slides. What
should be done to give the same background colour to
all the slides?

When you select a suitable background colour from
Page in the Format menu, a question (Background settings
for all pages) appears. Click on Yes. All the slides get the
same background colour. Is there any other way to get
the same background?

Slide Template

Slide templates are used
for getting uniformity on
the slides used for
preparing presentations.
Various built-in templates
are available in
LibreOffice Impress. Free
downloadable templates
are available on the
Internet too. If needed,
you can download such
templates and include
them in your
presentations. The slides
which are prepared using
a template will have the
following features:

♦ one design

♦ one background colour

♦ uniqueness in fonts
Used Format

Page   Background,

but does not turn

out correctly.

Shall we use

Insert

Duplicate Slide?
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Activity 7.1 - Select a template

Impress contains provisions for providing the same
background to all the slides. Let’s examine how the
templates can be included.

♦ Click on the Master Pages tool which is seen on the
side of the presentation window (Pic. 7.1).

♦ Select the template from the slot below the option
Available for use in Master Pages window.

You have already set the selected template as the
background of the slide. Now, insert a new slide. What
do you see? The background of all the slides are the same,
aren’t they? You may now save the prepared presentation
in the folder after giving it a file name.

Now, you may include information and pictures
needed for the presentation. You have practised how to
include pictures and information in a presentation in the
previous class, haven’t you?

Pic. 7.1 Impress window

Scrolling texts in
presentations

You can make scrolling
texts in presentations
also. You have studied in
Standard VIII about
giving animations to
texts. Follow the steps
given below to make
scrolling texts.

♦ Type the required text
using the text box.

♦ First, select the text.
Then, select Text
Animation seen in the
box when you click
open the Text from the
Format menu.

♦ Click on Scroll
Through option seen
in the box below Effect
and select suitable
direction from
Direction and then
click OK.

What shall
we do to see

the words
again?

When we include a
picture, the words

we typed have
disappeared!
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Activity 7.2 - Let’s include a picture and arrange it

This happened because the picture came on top
of the text. If you can place the picture behind the text,
you can solve this problem. How can this be done?
Follow the instructions given below.

♦ Click on the picture and select it.

♦ Click on Arrange from the Format menu and
select Send to Back.
(You can right click on the picture and perform
this process.)

Observe the changes that happen when you click
on the other options available on the Arrange menu.

You can also use the Arrange tool in the tool bar to
perform this process.

Activity 7.3 - Include a video

You have already included pictures and
information. Shall we include a video in our
presentation? How can this be made possible?

♦ Select the slide in which the video is to be
inserted.

♦ Click on Audio or Video from Media seen in the
Insert menu and include the video you want
to insert.

You can also click on Audio and Video tool to insert
a video (Pic. 7.2).

Click and select the video that appears on the slide
and adjust the size of the video window, if necessary.
Now, view the presentation. Videos of all formats may
not play in the presentation if inserted like this. For
such videos you can use the Interaction option.

Activity 7.4 - Provide interaction

It is common that while using websites you visit
new pages when you click on the links provided in it.
Like this, you can link to the video file from the
presentation using Interaction tool. (You can link video
files on any format in this manner.)

Pic. 7.2  Window that includes

audio-video tool

Add audio files

You can insert audio files
in the same manner as
you inserted the video
files. Here, you have to
select the audio files and
insert them instead of the
video files.

Into the slides...

You can link into a slide
using Interaction. Select
Go to page or object  from
Action at mouse click.
Select Target (Slide No)
and click OK.
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♦ Select Object (text, picture, etc.) on the slide you

intend to include in the Interaction.

♦ Select Interaction in Slide Show menu. You can click

on Interaction tool and open the window (Pic. 7.3).

♦ When the Interaction window opens, select Go to

document from the box near the Action at mouse click

(Pic. 7.4).

♦ Click on Browse and select video file and click OK

(Pic. 7.4).

What all activities in this
way can be done using
Interaction? Identify other
options and their uses in the
Action at mouse click box and

list them in the given table

(Table 7.1).

Think of including

additional information

related to the seminar. What

are the sources from which

you can collect the

additional information?

Pic. 7.4  Interaction window

Table 7.1

Action Target

No action

Go to previous slide

Go to next slide

Go to first slide

Go to last slide

Go to page or object

Go to document

Exit presentation

to move back to the previous slide

to exit the presentation

Pic. 7.3  The window that

includes Interaction tool

Interactive buttons

The buttons needed for

giving Interaction can be

drawn using the tools in

the Drawing toolbar. After

selecting the button, click

on the Properties tool in

the Sidebar. What

changes can be made in

the button?

Action and their targets
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Is it practicable to include all the additional

information you have collected in the presentation? You

can make use of the provision of hyperlink like

Interaction.

Activity 7.5 - Let’s hyperlink

You have seen a lot of information in internet related

to global warming. Now, think of how to link the

presentation you have prepared to Wikipedia.

♦ Select the word in the slide which you intend to

hyperlink.

♦ You can enter the window by a click on the Hyperlink

tool or select Hyperlink in the Insert menu.

♦ Select Internet from the box on the left side of the

window (Pic. 7.5).

♦ Type the web page address (URL) of the file to be

linked in the Target box (Pic. 7.5). The text you

selected to give hyperlink will appear in the Text box.

This will be the Mark-up Text.

Now, view the presentation. What changes occur
when the mouse pointer reaches the top of the mark-up
text? And what happens if you click on it? You reach the
web page which you hyperlinked earlier, don’t you?

Pic. 7.5  Hyperlink window

Mark-up texts

You might have

identified some words

having blue colour

underline while you visit

sites like Wikipedia. You

might have noticed the

changes when you bring

the mouse on the top of it.

These are called Mark-up

Texts. When you click on

it, you reach the file to

which the text is related.

This process is called

Hyperlink.

While linking files

If you change the
position of the files you
included in a
presentation through
Interaction, Hyperlink,
etc., it may not work
properly in the
presentation. Therefore,
it is better to copy such
files to a folder in which
you intend to save the
presentation and then
link them to the
presentation.
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Activity 7.6 - Let’s insert a table

If you include the information you have gathered for
the seminar in the form of a table, the presentation would
become more effective. Consider the following steps to
include a table in the presentation.

♦ Select the slide in which you want to insert the table.
Then, click on Table in the Insert menu.

♦ In the box that opens, type the number of rows and
columns and then click OK. (You can also click on
the Table tool and select the number of rows and
columns required in the table.) Now, include the
information in the table.

♦ You can make the table attractive using the tools that
appear in the Properties window while selecting the
table.

You might have understood how to add rows and
columns in a table. Select the table and right click on the
mouse to see the options available in it and their uses. If
you insert a chart in the slide with the details of the table,
don’t you get a clear idea?

Activity 7.7 - Insert a chart

You have studied how to insert a chart in Spreadsheet
in Standard VIII. Now, you may follow the steps given
below to insert a chart in the presentation slide.

♦ Select the slide in which the chart is to be inserted.

♦ Click on Insert menu and then on Chart, the window
to insert the chart will be opened. (This can be done
by clicking on the Chart tool.)

♦ Format the chart using the tools marked in the picture
(Pic. 7.6).

♦ After formatting, click on the outer part of the chart
and include it in the slide.

Include data in
charts

♦ To add data to the
chart, click on Data
Table and provide the
data in the window
that opens. You can
also add or delete
rows and columns in
the chart by giving
details here (Pic. 7.6).

♦ Click on Chart Area or
Chart Wall and
provide suitable
background colour to
the slide.

♦ Click on Title and give
names to the X and Y
axis of the chart.

How can I include

a table in a slide?
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Activity 7.8 - How to add presentation files

Can you add the presentations prepared by other
groups on the seminar topic, to your presentation. How
is it possible?

What should be done to add a presentation wholly
or partly to a presentation  file? Let’s see how it is possible.

♦ Select the slide in which you have to add the
presentation file.

♦ Select the presentation file you intend to add. Select
File from the Insert Menu. Now, click on Open and
insert the presentation file.

♦ Then, click OK in the Insert Slides/Objects that
appears.

Did you notice that all the presentation files that you
have selected have been included?

If you want to add only a part of the presentation or
only certain slides to the presentation file, select and copy
those slides and paste in the Slide Pane wherever it is to
be added (Pic. 7.1).

Did you notice the change in the background colour
of the slides you added now? To solve this problem, click
on the Master page and select a suitable template from it.

Pic. 7.6  Window for inserting chart

Slide Pane...

What are the facilities

available in Slide Pane?

♦ You can see the
Thumbnail view of
the slides.

♦ You can easily select
a slide.

♦ Copy - Paste a slide.

♦ Add new slides to
the presentation.

♦ Delete a particular
slide.

♦ Rename a slide.

♦ Arrange the slides.

♦ Hide a particular
slide.
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Now, let’s slide show the presentation.

After the slide show of the presentation, Vipin
identified that certain texts and pictures are repeated and
some are not in the expected position. His teacher told
him that it was due to some problems in giving animation
to the presentation. If we animate an object more than
once, this problem may happen. How can we overcome
this problem?

Activity 7.9 - Slide sorting

You have seen how to change the arrangement of
animation. Now, how can you change the arrangement
of slides?

♦ Click on the Slide Sorter tab seen above the
Workspace. Now, you can see all the presentation
slides in one window.

♦ Drag the slide which you want to change the position
and drop it in the correct position.

♦ Click on Normal tab to go to the previous window.

Haven’t you saved the works you did till now in a
folder? Now, you may present the slides before your
friends.

♦ Click on Master in the View menu and select Slide Master.

♦ A window as shown in the picture appears. (Note that here you can see only the
master slide.)

♦ The colours, pictures, etc. you add as background will be seen in all the slides.

♦ Select suitable one from Date Area, Footer Area, Slide Number Area and add data
in it. This will be visible in all the slides.

Let’s make master slides

Did you notice the templates that you used while
selecting the slide design? You can make similar
templates of your own.

To arrange animation

♦ Select a slide.
♦ Click on the Custom

Animation tool in the
Sidebar.

♦ Select Animation and
click on the UP/
DOWN button.

Facilities to make
changes in animation,
remove animation and
preview animation is
available in this
window. Try and find
out these facilities.

Pic. 7.7

Custom Animation window
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♦ If you prepare master slides and
prepare slides, such designs cannot
be edited in Normal View Mode.

♦ Whatever change/editing done in
the master slide will be visible in all
the slides.

♦ To go back to the Normal View
Mode, click on Normal View in View
menu.

The learner:

♦ prepares presentations using Impress software templates.

♦ brings the typed text to front or back of a picture in the slide using Arrange tool.

♦ inserts a video in the presentation slide.

♦ links Interaction from one slide to another slide or to another file.

♦ links a presentation to another file using the technique of Hyperlink.

♦ inserts a table in the presentation; includes details in the table; formats the table.

♦ inserts a chart in the slide; adds necessary data to the chart; gives names to the chart
and slide.

♦ adds a prepared presentation completely or partially to another presentation.

♦ arranges the slides in the proper order using Slide Sorter facility.

Let’s evaluate

Significant learning outcomes

1. Which of the following tools from Arrange will you select to bring a typed text or
picture to the front of the slide?

a) Send to back b) Send Backward

c) Bring to Front d) Bring Forward
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2. Which of the following from the Interaction window will you select to link the first
slide to the fifth slide in a presentation?

a) Go to document b) Go to page or object

c) Go to first slide d) Go to next slide

3. How will you remove a slide temporarily from a presentation?

a) delete the slide b) hide the slide

c) sort the slides using Slide Sorter d) click on the master page

4. Which of the following icon in the Hyperlink window will you select to link a
presentation in a previously prepared file through Hyperlink?

a) Internet b) Mail

c) Document d) New Document

5. What will you do to add two slides from another presentation to the presentation
you have prepared?

a) Insert slide b) Insert Duplicate slide

c) Insert media d) Insert file

♦ We have studied in the earlier classes on how to convert a word processor file to
PDF. Convert the presentation file you have prepared to PDF format.

♦ Prepare a presentation as part of the IT Quiz competition in the School IT fair by
setting a master page using Slide Master.

♦ Prepare a presentation based on the topic ‘Ozone depletion and its Remedies’ a
lesson from your Chemistry Textbook.

♦ Prepare notes on the three important parts seen when Impress opens and its major
features.

♦ Provide beautiful borders to the pictures in the presentation you have prepared
using the Frame tool in the Drawing toolbar.

Follow-up activities
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Anu and Amina are watching the programmes of
State School Kalolsavam from the Kalolsavam site. Apart
from the results of the competitions, all the stage
presentations are available as video in the Kalolsavam
site. “All the competitions staged in the Kalolsavam and
all the important events are shown in the social media”,
says Vipin.

Let’s prepare a page for the Kalolsavam

You have studied in the earlier classes that a website
contains more than one web page. We can also construct
a website including the details of the major events of our
school. We can add information about various
programmes organised in our school related to Sports,
Youth Festival, etc. and also programmes of excellence
in different pages of the school’s website.

Let’s see how the website with different pages can
be constructed. Shall we prepare a web page
demonstrating the programmes of the School Kalolsavam
this year?

What are the details and information to be included
in the web page that we intend to prepare?

Chapter 8Chapter 8Chapter 8Chapter 8Chapter 8

Making a Web Page

How will you
make a

website?

Shall we make a
website to publish
the programmes of

our school?
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Activity 8.1 - Deciding the content

Visit the various websites of the Internet. Examine
each page of these websites and find out what kind of
contents are included and how they are arranged.

Likewise, don’t we want to make our web page
attractive? For this, list the contents that we can include
in the Kalolsavam page.

♦ Heading

♦ Pictures

♦ ...........................................................................................................................

♦ ...........................................................................................................................

Now, let’s start preparing the web page. You know
that web pages are opened on web browsers. But web
browsers cannot prepare web pages. How the texts,
images, sounds, videos, etc. shall be displayed on the
web page will be given as instructions in the Text editor.
Browsers visualise the contents of this web page according
to the instructions in it. The language used for preparing
such web pages is called Hypertext Markup Language.

Activity 8.2 - Let’s build a web page

Tags or HTML elements are instructions used in
HTML language to define the contents of a web page
and its arrangement. Tags are used by typing them in

< > symbols .

H T M L

Web pages are inter-
connected hypertext
documents. The markup
language used for
preparing these web
pages is called HTML.
In ancient days, symbols
were used to give
instructions to the
typesetter to set the type
for printing. The size of
letters, colours to be
used, slant of letters, etc.
for the text to be printed
were represented using
symbols or codes called
markups. Since HTML
language is marking up
the content, it is called
markup language. The
fifth authorised edition
of HTML is HTML 5.

HTML tags

When a web page is prepared <html> (opening) tag is
given at first to denote the beginning and </html>
(closing) is used at the end to denote the ending of the
page. The contents are given in between. The
instructions that contain an opening and a closing tag
is called container tags. Those that do not need a closing
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tag is called an empty tag.

The common structure of HTML tags in
a web page is given in Pic. 8.1. The main
tags that comes in between <html>    </

html> are <head> tag and <body> tag.
Details related to the page, but not the
content should be included in <head> ......

</head> tag. For example, <title> </title>

tag. This is the instruction to show a text
on the title bar when a web page is
opened (Pic. 8.2). The content to be
shown in the web page should be
included in <body> ..... </body> tag.

Pic. 8.1 HTML page layout

Pic. 8.2 Title bar

♦ To prepare a Kalolsavam page of your school, open
a Text editor and type the instructions as given  in the
picture (Pic. 8.3).

♦ Save this file in the sub folder Web page in your folder
with a name ‘kalolsavam.html’ and close it. (This text
file becomes a web page when you give the file
extension .html)

Pic. 8.3  Basic HTML tags
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Activity 8.3 - Adding a page heading

Enter the name of your school as the heading in the
web page where Content Area is typed and enter
‘Kalolsavam - 2017’ as sub heading (Pic. 8.3).

To make the changes in the web page, make changes
in the page source. Open the web page you have
prepared in Text editor using the command Open with
→ gedit. You can edit the html instruction and make
changes in the web page.

♦ Open the file you have saved (Double click).

♦ Examine how the web browser displays the details
you have entered in the web page.

◊ Where is the text School Kalolsavam shown?

◊ What other contents can you see in the page?

Now, you can add information to the web page. You
have decided the contents to be included in the web page,
haven’t you? What should appear on the top of the page?

Look at the headings and sub headings in your
textbook. Like this, there are various tags which can be
used to show the headings and sub headings in a web
page. Use the tags given below to give a suitable heading
to your Kalolsavam page.

<h1> FIRST HEADING </h1>

<h3> THIRD HEADING </h3>

Heading Tags

FIRST HEADING

SECOND HEADING

THIRD HEADING

<h2> SECOND HEADING </h2>

Table 8.1  Headings

Oh! I cannot
change the web

page.
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Read the HTML instructions given by Anu to include
the headings and instructions that the browser displayed
(Pic. 8.4).

Pic. 8.4  Instructions given to include a heading and the web page window display

Compare this instruction with the one you have
already prepared. Observe the changes happening to the
heading when you use h3, h4 tags instead of h1, h2 tags.
Find out the heading tags other than h1, h2, h3 and h4.

You might have heard the quote “A picture is worth a
thousand words”. Don’t you see the images in the websites
you have visited? The web page becomes more attractive
if suitable images are added to the web page.

Prepare a banner in Image editing software for your
Kalolsavam page. Let’s familiarise ourselves with

inserting the banner in the web page.

Activity 8.4 - Let’s include a banner

You know how to insert a picture in the word
processor, don’t you? In a web page, image file can be
inserted with the help of the HTML tag <img>. Along with
this instruction, the details of the kind of image to be
included, from where the image is to be included, the
size of the picture, etc. can be given using the attributes
src, height, width, etc.

For example: <img src=”images/banner1.jpg”

height=”42" width=”42">

Attributes

Attributes are instructions
given in a tag for
additions to be made in
it. Attributes may be
given in the opening tags
only.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

102

Making a Web Page

Information and Communications Technology - IX

Pic. 8.5 Folder in which the web

page is saved

Pic. 8.6 Picture tag

The background colour of a page is one of the major
factors that make a web page attractive. Background
colour should suit the content and the topic of the web
page.

Activity 8.5 - Change background colour

With the help of the hints given below, give suitable
colour to the web page you have prepared.

♦ To change the background colour of the web page,
an additional instruction ‘bgcolor’ should be given
in the opening tag <body> (<body bgcolor= ”lightgreen”>).

♦ You can give any background colour viz. green,
yellow, blue, black, etc.

♦ You can indicate a colour using hexadecimal colour
code instead of names of colours like green, blue, etc.

As you have to give instruction for inserting a picture
and its position, the picture you intend to include can be
saved in the folder in which the web page is saved. The
pictures can be saved in a new folder (e.g. Images) inside
the folder ‘Webpage’.

To insert this picture in the web page, open the web
page in Text editor. Type the instruction <img src=”images/

banner1.jpg”> as in Pic. 8.6. Don’t give a closing tag for
this instruction. Save this web page and observe how this
page appears in the browser.

Hexadecimal colour code

Relative path and

Absolute path

The position of an image
file is represented in two
ways. Relative path - This
is the way in which the
image is inserted here.
But the path to the image
will be clearly defined in
the Absolute path. The
absolute path of the
above image may be as
follows: /home/user/
Desktop/webpage/images/
banner1.jpg

You can mix colours like
red, green, blue, etc. in
various quantities to form
new colours. A colour
containing red, green and
blue beams with the
intensity from ‘0’ to ‘f’, 16
codes (hexadecimal) can
be represented using 6
digits. (e.g. :#5fd0ff)
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Activity 8.6 - Adding a Text

Given below is the web page prepared by Anu in
which the Kalolsavam items are included (Pic. 8.7).
Compare it with the Kalolsavam page prepared by you.
What differences do you find?

Pic. 8.7 Web page that includes Kalolsavam items

Some HTML tags are given overleaf which will help
you to make the words attractive (Table 8.2). You may
try the tags and make the words attractive.

♦ Anu has included the Kalolsavam items in it.

♦ The word ‘Items’ is given in bold letters.

♦ Given colour to words.

♦ ...........................................................................................................................

♦ ...........................................................................................................................

You may also add the Kalolsavam items below the
picture in your web page as in the given model and make
changes in the page source.

Insert paragraphs

When details are entered
in a web page, you may
have to enter it in more
than one paragraph. The
text can be split into
paragraphs by giving the
tag <p> ... </p>. This is how
paragraphs are inserted in
a web page.

Line by line

Even though we type the
Kalolsavam items line by
line in the web page
source, they appear in the
browser as continuous
words according to the
availability of space. To
denote the end of a line,
the tag <br> can be given
to arrange the words in
different lines.
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Table 8.2  Formatting tools

Objective Tags How to use

to make a text bold <b> <b> Kerala Nadanam </b>

to italicise a text

to ‘underline’

to give colour to the
text

to change the font

to increase the size
of the font

to change the colour
and size

to align at the centre

<i>

<u>

<font color=”red”>

<font face=”verdana”>

<font size=5>

<i> Nadanpattu </i>

<font color=”red”

size=5>

<center></center>

<u> Ganamela </u>

<font color=“blue”>Bandmelam

</font>

<font face=“verdana”>Bandmelam

</font>

<font size=5>Kathaprasangam </font>

<font color=“red” size=5>

kathaprasangam</font>

Don’t you remember the table used in the presentation
software? Likewise, you can include a table in a web page
and display the contents in different columns and rows.

Look at the Kalolsavam items prepared in the web
page (Pic. 8.7). Now, discuss the advantages of arranging
these items in two columns as shown in the picture (Pic.
8.8).

Pic. 8.8 List of Kalolsavam items

<center>item</center>

Don’t forget to

use the closing

tag.
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Activity 8.7 - Let’s include a table

Given below (Pic. 8.9) are the instructions to include
the Kalolsavam items in a table of two columns. Like this,
prepare a table in your web page. Open the browser and
examine how it appears.

Pic. 8.9  Table tags

You might have seen web pages with videos in it.
Now, let’s see how to insert a video in the web page.

Instructions Use

to include a table.

<tr>

to include rows and columns (cell) in all lines.

<table border=1> to make the lines of the table appear

Table 8.3  Instructions to include a table and its process

The instructions to include a table and its process
are given below. Complete the missing parts.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

106

Making a Web Page

Information and Communications Technology - IX

Activity 8.8 - Let’s insert a video

Video files can be inserted in the same manner as
image files. The videos that are to be used in the web
page can be kept in a folder near the web page (e.g.
“video”). Use the instruction <video> </video> to insert the
video in the web page.

Insert a video of the programmes in your web page
with the help of the instructions given below and see how
it appears in the web page.

<video width=”400" height=”250" controls>

<source src=”video/oppana.mp4" type=”video/mp4">

</video>

In the <video> tag, out of the three attributes, width
and height are provided to adjust the size of the video as
it appears. To show the play and stop buttons of the video,
you have to include the ‘Controls’ attribute. Two attributes
‘src’ and ‘type’ are given in the source tag.  The attribute
‘src’ tells you which video is to be added, and the attribute
‘type’ tells you which type of video is used.

e.g. type=”video/mp4" or “video/ogg” or “video/webm

Let’s design a table

Won’t it be better to add the video to the table?
Discuss with your friends and find out how you can do
this.

Pic. 8.10  Tables for page layout

Design the page using table

You can design a web page
according to your wish by
preparing table/tables and
include words, pictures,
videos, etc. in it.
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You might have seen flash news in TV, haven’t you?

You can see words and pictures scrolling in various

websites. You can also scroll words in your web page.

Activity 8.9 - Scrolling texts

Scroll the text ‘Registration Started’ below the banner

of your web page.

You can scroll texts and pictures using the tag

<marquee> </marquee>. Most probably words scroll from

right to left in a web page. But you can give special

instructions to the attributes to scroll the text rightwards,

downwards or upwards.

For example: <marquee direction=right> Registration Started</

marquee>

You might have noticed the change that happens to

the mouse pointer when it reaches the top of certain words

or pictures in websites. See what happens when you click

on it. Another page opens. These are hyperlinked texts

named Hypertext. You can give hyperlink from your web

page to other pages or to the school website or School

Wiki.

Activity 8.10 - Hyperlink to School Wiki

You have given the name of your school as the

heading of your web page. Now, hyperlink the school

name and when you click on it, School Wiki will open.

Hyperlink

<a> - - - <a> is the tag which is used to give hyperlink

or to make a word in a hyper text. You have to indicate

the attribute “href” to denote the place to link the text.

For example, if you want to give hyperlinks in the

name GGHSS Malappuram to the School Wiki, give the

instruction as: <a href=“http://www.schoolwiki.in”> GGHSS

Malappuram </a>.
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When you prepare your school website, the pages

in it can be linked to the main page by giving hyperlink

to the file name of the main page including its path.

The learner:

♦ prepares web pages using the HTML code.

♦ gives heading and sub heading to School Kalolsavam web page.

♦ inserts picture in a web page.

♦ changes the background colour of the web page.

♦ includes words/text in a web page.

♦ changes the size of the font, make it italics, bold, gives colour to the words in the

web page.

♦ includes a table.

♦ includes a video in the web page.

♦ scrolls the text.

♦ gives hyperlink to the words in the web page.

1. Which one of the following HTML tags can be used to give the heading of a page?

1. <title> 2. <br> 3. <p> 4. <h1>

2. Given below to the right are the HTML instructions prepared by Saleena to make a
web page. Prepare a web page using these instructions. Are these instructions
adequate to prepare this web page? Make necessary changes in these HTML
instructions.

Let’s evaluate

Significant learning outcomes
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3. Match the list of items with the HTML instructions suitably.

1 Image <body bgcolor>... </body>

2 Underline <a>.... </a>

3 Hyperlink <u>.... </u>

4 Background colour <p>...</p>

5 Paragraph <img src=...>

♦ Prepare a web page which shows the sports activities in the school.

♦ Prepare a page displaying the excellence of your school. Give hyperlink to the
pages.

♦ Include a table of Kalolsavam winners in your web page. Give different colours to
the words and background of the table.

♦ Visit the page source of the website www.itschool.gov.in. Evaluate the usage of
certain familiar instructions (Right click →→→→→ View Page Source).

♦ Prepare a web page keeping in mind any of the web pages you have visited on the
Internet. (Design the layout of the web page using <table>)

Follow-up activities
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Vipin and Varsha are preparing a video documentary of Kalolsavam programmes to be included

in the Kalolsavam web page prepared by the IT Club. The details to be included in the

documentary were prepared by Saleena and based on that a visual presentation was also

prepared by Anu.

Which documentary would you like to prepare?
Discuss with your friends and select a programme
conducted in your school for preparing a documentary.

Chapter 9Chapter 9Chapter 9Chapter 9Chapter 9

If you prepare video documentations of the

important programmes in your school, it will be helpful

for you to re-examine and publish them at a later time.

Which programmes can be documented in this manner?

♦ Pravesanolsavam

♦ Sports Meet

♦ Independence Day Celebrations

♦ Tour programme

♦ ...........................................................................................................................

♦ ...........................................................................................................................

♦ ...........................................................................................................................

Video Editing
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Then, shoot the programme with details that you intend
to include in the documentary and save them in your
computer.

What else should be done to the video clips that you
have saved in the computer, to combine them to make a
video documentary? List the process.

♦ arrange the videos

♦ edit and remove unwanted parts

♦ ........................................................................................… -

♦ ........................................................................................…

You have studied the process of editing a text or
image or sound in your previous class. Recall the process
of editing.

Like this, let’s see how you can prepare a video
documentary using OpenShot Video Editor which is
included in the IT@School GNU/Linux.

Activity 9.1 - Let’s familiarise openshot

Open OpenShot Video Editor in your computer and
examine the facilities provided in it. (Pic. 9.1)

Pic. 9.1 OpenShot Video Editor window

Video editing

Video Editing is the
process of arrangement
of videos in a suitable
manner and editing and
removing unnecessary
parts from a video. It also
includes the process of
adding dialogues,
background music,
special effects, title, etc. to
the video and organising
it for a presentation. In
earlier days, tape-to-tape
linear video editing
using video tapes were
common. Later, with the
introduction of
computers and video
editing software, non-
linear video editing
using digital facilities
became popular. Thus,
editing a part of the
video file with perfection
and speed was easily
possible.

Now, there are various
software which help in
the process of video
editing. OpenShot Video
Editor, Kdenlive, Kino,
Pitivi Video Editor, etc.
are some of the video
editing software
available in GNU/Linux.
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Activity 9.2 - Let’s start a video project

You are now familiar with OpenShot Video Editor,
aren’t you? Now, let’s start editing videos. For this, we
have to start a new project.

Before we start video editing in OpenShot Video
Editing, you have to decide to which file format the video
file that you prepare is to be exported. Along with this
you have to prepare a project profile which is suitable
for the prescribed format.

You may select a profile suitable for your project by
making use of the process given below.

♦ Select New Project from the File menu and click open
the window Create a Project.

♦ In the window that opens, you may provide a name
for the project, a place to save the file and a profile in
the slots of Project Name, Project Folder and Project
Profile respectively. Then, click on Save Project and
save the entries made.

Now, you may open the software and save your file,

selecting a project profile suitable for your video

documentation.

Activity 9.3 - Include files

You have saved the collected video clips in your

folder, haven’t you? You have to include these video

clips in the timeline in OpenShot and then perform the

editing process.

OpenShot video editor

OpenShot Video Editor is

a simple video editing

software. The project was

started in 2008 by

Jonathan Thomas, an

American, with the aim of

producing a simple and

stable video editor for

GNU/Linux. Within two

years he produced a

stable version. The

OpenShot Video Editor

developed using Python

programming language

supports many other

video file formats.

While selecting Project Profile

There is a possibility of a difference in the quality of the video that is exported, if

you do not set the Project Profile in a suitable way. If you propose to export the

video files to a more qualitative format, then, you can set the Project Profile in DV/

DVD PAL. You can also include a new profile in OpenShot by clicking on in the

order Edit →→→→→ Preferences →→→→→ Profiles →→→→→ Manage Profiles. The new versions of

OpenShot supports HD, HDV (High Definition) video formats also.
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Insert the clips in the time line based on their time

with the help of the instructions given below:

♦ You can include a video or an audio file which you

want to edit in OpenShot project using the File →→→→→
Import Files.

♦ The files you have included can be seen in the Project

Files section.

♦ Video transition, video/audio effects are set in

Transitions, Effects tabs respectively.

♦ Drag the video clips you want to edit from Project Files

in their chronology of time to the timeline tracks

(Pic. 9.2).

Pic. 9.2  When videos were included in the track

♦ You can run the clips or stop running them by pressing

the Space key in the keyboard or click on the Play/

Pause button in the video preview window.

You may include the parts of the video from the

Project Files to the Timeline track. You can add or cut

files in these tracks.

Timeline

In the video editing

software, film, picture,

sound, title, etc. can be

edited at the timeline

based on their timing.  In

a timeline, normally

there are video and audio

tracks. The process of

editing is done by

inserting the video files in

the video track and the

audio files in the audio

track. But in the existing

version of OpenShot

there is no separate track

for sound clips. Instead

the video clips or video

tracks are disabled and

they are changed to audio

clips/tracks.
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How can you remove the unwanted parts from a

video?

♦ Identify the part to be removed by moving the

Playback head.

♦ Mark the part to be removed using Add Marker Tool

. To avoid the marking, right click on it and click

on Remove Marker.)

♦ You can cut the marked parts using the Razor Tool

 (Pic. 9.3).

♦ If you want to delete an unwanted part of the video

from the track, Right Click on the video using the

Arrow Tool  and click on Remove Clip.

You have removed the unwanted parts from the

video clips. Now, include the existing video parts in the

track and edit them and arrange them (Pic. 9.4).

Pic. 9.3  When a video clip is cut

using Razor tool

Activity 9.4 - Let’s compile video files

When the video clips that were to be edited had been

dragged and played, Vipin and Varsha had some doubts

regarding them.

Playback head

The video clips in the
track appear in the video
preview according to its
position on the Playback
Head tool. When you
activate the Play button
on the timeline, the
Playback Head starts
moving through the clips
on the track. During its
movement, the Playback
Head displays/
produces sounds of all
the files on the track on
its path. While
displaying, the priority
will be given to the video
clips on the top of the
track. If there are no
videos on the top track,
the Playback Head
displays the video file
placed in the track just
below. But for audio
clips this file is not
considered.

Shall we

remove some

parts from it?

Do we have to

include the whole of

the video clip in the

documentary?
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Pic. 9.4  When the edited video parts are arranged on the track

Slide transition

You know how to prepare a slide presentation using

the presentation software. You have also studied how to

make the presentation attractive by giving slide transition

effect to the slides.

You usually use the technique of slide transition

when you have more than one slide to present. What are

the advantages of providing slide transition effect to

slides?

♦ Ideas in each slide will be carefully viewed by the

audience.

♦ ...........................................................................................

Activity 9.5 - Let’s effect transition

In films and telefilms, transition effects are provided

in between scenes to realise the change of the scene. The

video documentary that is prepared by you can also be

made attractive by providing transition effects. For this,

follow the process given below.

♦ Click on Transition tab.

♦ Include suitable transition effects in between the

video clips that are arranged in the track (Pic. 9.5).

Special Notice

Do not forget to save each activity that you perform while editing. Then only it will
be saved in the file. So, click in the order File →→→→→ Save Project and save the project
intermittently. The OpenShot project file format is osp.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

116

Video Editing

Information and Communications Technology - IX

Pic. 9.6  Adjusting the direction of transition

Pic. 9.5  When the videos were provided transition

The transition time included in between the video files can be adjusted using the
Resize tool. For this, click on the Resize tool and then click on the first or last part of
the transition and drag according to the length you wish.

Activity 9.6 - Add effects

You might have understood how transition effect can
be added to the place where two video clips join together.
Apart from this, provision for adding effects to all video
clips is possible in OpenShot Video Editor. Follow the
process given below and add suitable video effects to
the clips.

♦ Right click on the video clip which you have included
on the track.

While providing transition

Arrange the video clips on the top track and just below it to provide transition
between the two video clips. Select a suitable transition from the Transition tab and
drag it to the place where the video clips join together. Right click on the transition
and click on Switch Direction, if you wish to change the direction of the transition.
Observe Pic. 9.6.
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♦ Provide effects like Fade, Animate, etc. one by one to

the video clips and play them through Video Preview

window and see how they work.

♦ Identify effects and include them to the video clips

suitably.

Collecting audio files

Do you wish to include a description along with the

documentation? For this, first you have to prepare the

text to be included as description. To include the

description into a video file, it has to be converted into a

digital format.

Record the text for description using Sound recording

software and convert it to an audio file format (wav, mp3,

ogg). Save it in your folder. You can either use Sound

Recorder or Audacity software which you have

familiarised in Standard VIII. If you intend to add music,

collect such files in your folder well in advance.

In the timeline of OpenShot Video Editor, there are

normally two tracks. If we include videos in the two tracks,

how can we include an audio file in it? We need a new

track for this purpose. See, how can a new track be added

and how the sound file can be inserted?

Activity 9.7 - Include sound files

♦ To add a new track, click on Add Track  icon or

right click on the existing track and then click on Add

Track above/Add Track below.

♦ Include the sound files in the track as you have

included the video clips in the track (Pic. 9.7).

♦ To give sound or description to a video, place the

sound clip in the track below the concerned video clip.

♦ If the sound that exists in the video clip is not needed,

remove that sound and include the new sound. Click
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on the audio icon (Speaker symbol) and you can

disable the audio.

Titles

You have seen in the beginning and end of

documentaries and films, the names of persons who

worked behind such films (titles). Like this, you can also

include titles/courtesies in your documentary. Note

down the titles you intend to include in your

documentary.

♦ School IT Club presents

♦ ............................................................................................

♦ ............................................................................................

♦ ............................................................................................

Now, perform the following activities.

Activity 9.8 - Let’s include titles

♦ Open the Project and select New Title from the Title

menu. Now, open the Title Editor window (Pic. 9.8).

♦ Select a title style from the box on the right side. Then,

click on Create New Title to give a file name for the

title. (Each title should be saved as a separate file.)

Activity  9.7  Sound file included in the track
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Pic.  9.8 Title Editor window

♦ Include the title in the window that appears and click

on Apply. The title returns to the Title Editor window

(Pic. 9.8).

♦ When you give Apply on the Title Editor window,

they appear on the part of Project Files.

♦ You can include the titles from here by dragging them

to the track and arranging them in the place where

you want them to be as you have included the video

files earlier.

Activity 9.9 - Export the project

The video and audio files are now placed in different

tracks in OpenShot. If you want to make this file work as

a video, it has to be converted into a video file. Then, you

can play it using a media player. You can export your

project file to video format by following the process given

below.

♦ Save the project.

♦ Open Export Video window either by clicking on

Export Video  button or by selecting Export Video

from the File menu.

♦ Type the file name and select the folder to be saved,

profile, additional options of the profile, etc. (Pic. 9.9)

♦ Close the project window when the process

is completed.

To move the video
clips which are added
on the track to a slight

distance forward

If you want to move the
video clips which you
added on the track to a
slight distance forward,
right click on the video
clip and click on Shift
clips in the window that
appears. Then, type the
time (in seconds) and
move the video clips to
the desired distance
forward.

Video file formats

Digital videos are stored in data computers
in various video file formats. Some of the
important video file formats are ogv, mpg,

mp4, avi, flv, mov, wmv, 3gp.

Pic.  9.9 Export Video window
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Activity  9.10 - Let’s play the videos

Did you play in the computer the video files you

have exported? You can do this in two ways: Double click

on the video files or follow Right Click →→→→→ Open with

and select a suitable media player and play the video

files. Can you open your video documentary in all the

media players in the computer? This video may not work

in websites, tablets, etc.

In such cases, these video files can be converted to

other file formats with the help of software. WinFF,

HandBrake, etc. are software which helps to convert these

file formats in GNU/Linux system.

Activity 9.11 - Change video format

Let’s convert the video documentary that we have

prepared using WinFF software. For this, follow the steps

explained below:

♦ Open WinFF from Sound & Video menu.

Convert image files to video files

You might have stored many photographs of festivals/programmes held in your
school. Don’t you like to make a video file compiling all the photographs you have
stored? This facility is available in OpenShot Video Editor. Follow the process given
below.

♦ Open OpenShot software. Include all the image files into the Project files section

of OpenShot.

♦ Select the images that are to be included in the video files (Ctrl+A).

♦ Right click on the selected image files and then click on Add to Time Line.

♦ On the window that opens, click on Transition, Transition time, etc. seen on the

Transition tab. Then, click on the Add button.

♦ Now, the image files are given transition and are arranged on the track.

♦ You may export this to a Project Video file.
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♦ Select the details of the format you have to convert

and the folder in which you have to save the project,

from the columns seen below Output Details (Pic.

9.10).

♦ Click on the Add  button to include the file for

which the format is to be changed, into the software.

♦ Then, click on Convert  button.

Close WinFF window when the process is completed.

Now, check the output folder. You can see the file in it

with format change.

You may include this video documentary in the web

page that you have prepared earlier.

Pic. 9.10  WinFF window

Significant learning outcomes

The learner:

♦ opens OpenShot Video Editor software and identifies the various tools available

in it and list them.

♦ collects video or audio files in the computer for editing and includes them in

OpenShot project.

♦ drags each file to the Timeline area on the track and plays them using Playback

head and avoid unnecessary parts and arrange them accordingly.

♦ includes transitions and effects in the audio - video files to get better comprehension

and conveys ideas.

♦ includes titles and dialogues in a video documentary.

♦ exports a Project file to a suitable video file format.

♦ combines various image files into a video file.

♦ plays video files in various media players.

♦ changes the format of audio or video files using software.
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1. Which among the following is a video format?

(a)  mp3 (b)  wma (c)  wav (d)  avi

2. What is the need of exporting a Project file into Video Editing software?

3. Prepare titles for the video documentary related to a tour programme of your school

in OpenShot Video Editor software.

Follow-up activities

Let’s evaluate

1. Prepare a video documentary on the life of the famous poet ONV Kurup collecting

his poems, video clips and images from the Internet.

2. Prepare a documentary of the annual report to be presented on the School Annual

Day using OpenShot Video Editor software.

3. Prepare a short film using OpenShot Video Editor software on the topic ‘Drug Abuse

among School Children’.

4. Convert a video file you have prepared to another video file format with the help of

WinFF software.
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Atul and Divya, who won prizes in IT Quiz
competition, came to school with two tiny boxes.
Everybody was astonished when Atul told that the
box contained a small computer named Raspberry
Pi. Kunjamina expressed her doubt whether a
computer can be made in such a small size. Jobin at
once cleared the doubt by saying that most of the
smart phones can perform all the tasks performed by
a computer.

Have you ever thought of how the computers
are varied in size, performance and facilities? You
know that equipment like smart phones and desktop
computers work with the help of a number of big and
small components.

Day by day changes occur in the size and shape
of computers and its allied instruments because of
the high leap in the field of electronics and information
communication technology. What other changes do
you observe?

♦ reduction of size

♦ storage capacity increases

Chapter 10Chapter 10Chapter 10Chapter 10Chapter 10

Inside the Computer

Raspberry Pi

Raspberry Pi is a credit card
sized computer. The facilities
that are available in a normal
computer are also available in
it. But this consumes only very
low electricity. This computer
is designed mainly for
educational purposes. But
various computer programs
can be prepared with the help
of this computer. Using these
kinds of programs, this
computer has facilities to
control external equipment
also.
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♦ ...........................................................................................................................

♦ ...........................................................................................................................

Have you ever thought what process goes on in a

computer when it works?

A computer stores the data that is received through

the input devices and gives back whenever required

using the output equipment. We have familiarised

ourselves with some of the input and output devices we

use, in the previous classes. Try to remember those

devices.

The picture of an old model of a major input device

is given in Picture 10.1. Can you identify the device? This

is the old model of a significant input device called

mouse. Identify the differences between the old mouse

and the mouse we use today. Like this, drastic changes

are occurring in most of the equipment related to

computer.

In desktop computers, all components other than

input - output devices are kept inside a box called

cabinet. How are components like monitor, keyboard,

mouse, etc. connected to the cabinet? These are

connected to the ports seen in the cabinet of the

computer using different kinds of connectors. You have

identified the differences occurred in the shape and

function of a mouse, haven’t you? Likewise, the system

of connecting the input and output equipment to a

computer also has changed a lot.

Activity 10.1 - How to connect?

Interfaces of certain equipment and their names are

given in the table below. Examine the computers in your

school computer lab and write down in the table (Table

10.1), the names of equipment that can be connected to

each interface.

Examine how the keyboard and mouse that you use

is connected to the computer. Instead of using various

types of ports as in earlier days, USB ports are used more

Pic. 10.1 Old model mouse

Are all the input and
output equipment
connected to the

computer in the same
manner?
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Connectors Equipment Ports

PS2

Mouse

Keyboard

VGA (Video Graphic Array)

USB (Universal Serial Bus)

R J 45

TRS (Tip-Ring-Sleeve) Connector

.............................................................

.....................................................

......................................................

.....................................................

.....................................................

.....................................................

......................................................

......................................................

......................................................

Table 10.1 Various ports and connectors

......................................................

......................................................

......................................................

Be Careful!

Carefully fix the connectors to the ports or else the pins in the connectors will get
broken or bent. This will lead to disruption of information transfer and the equipment
may get destroyed.
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nowadays. What are the advantages of using USB

connectors? Modern computers need no ports or

connectors for different equipment. Moreover, the rate of

information transfer using USB technology is too high.

You have seen devices that can be connected using

USB.

Which output devices are used to present the visuals

from a computer?

♦ monitor

♦ projector

The output devices used to present the visuals from

a computer is the monitor (Pic. 10.2). What kinds of

monitor do you know? List them.

♦ CRT monitor

♦ LCD - TFT monitor

♦ ...........................................................................................

Did you understand that monitors are connected to

computers using Video Graphic Array (VGA) adaptors?

High Definition Media Interface (HDMI), Digital Visual

Interface (DVI), Display port, etc. are some of the modern

interfaces that are used to transfer the audio-video data

between equipment. You may collect more information

about these interfaces with the help of internet.

The data that we give as input in various methods

are later given as output through a complicated
Pic. 10.2 Monitor

 Universal Serial Bus

(USB)

USB is an advanced

technology that helps in

the speedy transfer of

information between

equipment. Apart from

ordinary USB connectors,

micro USB connectors to

be used in mobile phones

and cameras are also

available now. This helps

for providing power to

the machine also. You

might have seen mobile

phone chargers, fans,

lights, etc. working using

USB. Nowadays, in new

generation equipment,

we use USB 3.0 which can

transfer information more

speedily.

Visual display unit

Monitors are commonly known as Visual display units. They use various kinds of

technology.

Cathode Ray Tube (CRT) monitors consume more electricity than other monitors.
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processing. This is done with the help of microprocessors

in the Central Processing Unit (CPU) of the computer. This

kind of highly important microprocessors are fixed inside

a computer.

But the Thin - Film - Transistor (TFT) and Liquid - Crystal - Display (LCD), monitors

that we use nowadays consume very low electric power and is more clear and vibrant.

Light Emitting Diode (LED), Organic Light Emitting Diode (OLED) technologies are

also commonly used in display units. They provide clear and vibrant screen and

will also provide visual clarity.

Those who leave the
stage

Who controls the

activities in

computers?

Illustration 10.1  Working of CPU

Analyse the picture given (Illustration 10.1).

Microprocessors help to make basic mathematical

calculations and control the activities of input and output

equipment in the computer. The joint activities of the

software and other peripherals in the computer help in

getting the necessary information through output devices.

Do you think that the microprocessors used in

different computers have the same speed and same

efficiency? How can you identify the features of the

processors used in your computer.

You can know the details of the computer and the

peripherals in it without opening and examining them.

Many applications are available for this. Sysinfo is such

an application available in your computer.

With the advancement of

modern technology, many

sources and components

are replaced with new

technological devices. The

PS2 ports used for

connecting the mouse and

keyboard, serial ports

used for connecting

printers and the parallel

ports are examples for

such replacements.



12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890
12345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890

1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789
1234567890123456789012345678901212345678901234567890123456789012123456789012345678901234567890121234567890123456789012345678901212345678901234567890123456789012123456789

128

Inside the Computer

Information and Communications Technology - IX

Activity 10.2 - Different kinds of Processors

Open Sysinfo software in the computer (Pic. 10.3).

Observe the features of the CPU in the systems used by

you and your friends. Who is the manufacturer of the

processors? You may use the information given below.

Examine what additional basic information you can

collect about your computer which is available in

Sysinfo.

You might have understood that there are different

kinds of microprocessors. The microprocessors used in a

computer are the major factors which influence the

working speed of that computer. The microprocessors

contain a number of very small electronic components

which get heated while working. To absorb the emitted

Pic. 10.3  Sysinfo window
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Table 10.2  Features of the processor

Clock speed and cache memory

When a computer works, a number of information is transferred from the CPU and

to the CPU many times within a second. The rate of information transfer in a processor

is referred to as frequency or clock speed. If the clock speed of the processor is more,

then the instructions it handles also increases. Clock speed is normally measured in

unit Hertz (Hz).

When the CPU works, it depends mainly on the primary memory of the computer.

Sometimes the CPU which works very fast may find it difficult to get the information

in time. Hence, facility is available in the processor to retain the frequently used

information in the CPU itself. This is cache memory of the CPU. Processors differ in

their levels of cache memory.
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heat, heat sink and a small fan is attached to the processor.

New generation processors have the technology which

enables them to handle many instructions at the same

time. Frequency, cache memory, the speed of information

transfer to other components outside the processor, etc.

are features related to the efficiency of processors.

The information and instructions handled by the

microprocessors will be in the memory of the computer.

Where is the memory of the computer situated?

Imagine that you are preparing an article in Word

Processor software. If the power supply goes out, your

file will be lost. But what if you have saved the file? The

file can be used again. The file was in the temporary

memory of the computer before it was saved. But after

the file is saved, it is sent to the permanent memory.

Permanent memory and temporary memory

Computers store temporary information files in

RAM, a component which is made up of IC chips. When

the power supply goes out, the data stored in the RAM

gets lost. The operating system and the hard disk which

stores all the files are considered as permanent memory

of the computer.

If you increase the storage capacity of the RAM, the

processing speed of the computer increases. Examine the

RAM available in your computer lab. You can see the

name of the manufacturer and the storage capacity of the

RAM. Examine and record these details.

Activity 10.3 - Know the storage capacity of RAM

You are now familiar with the Sysinfo application

which helps you to know the details of the components

in it. Now, find out the capacity of the RAM in your

computer and write it in the space below.

♦ .....................................................................................

Random Access

Memory (RAM)

Drastic changes happen

to the structure and

storage facility of RAM.

We use big size RAM in

desktop computers and

smaller size RAM in

laptops. In gadgets like

smart phones, tablets,

etc., the RAM is inbuilt in

the mother board.

Nowadays we use RAM

which have many times

storage facility than the

RAM used earlier.
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How much percentage of the capacity of RAM is now

utilised by your computer for its working?

♦ ...........................................................................................

In some tasks like video editing, more memory than

the capacity of the RAM may be used for its functioning.

A part of the hard disk is kept apart for these purposes.

This is called Swap Memory.

How much is the Swap Memory available in your

computer?

♦ ...........................................................................................

Hard disks

You have seen that the permanent memory of the

computer is the hard disk. Normally all files including

pictures, music, videos and the operating system of the

computer is stored in the hard disk. Hard disk drives of

various storage capacities are now available. Try to find

out the storage capacity of the hard disk in your computer.

Is this facility available in Sysinfo? Examine.

Activity 10.4 - Let’s find the storage capacity
of the hard disk

Open Disks software in the operating system of your

computer.

Becoming smaller

The vacuum tubes used

in earlier computers

were very big in size.

After making transistors

using semiconductors,

the size of computers

became small. Later after

the invention of

integrated chips which

contained millions of

transistors, the size of

electronic equipment

became smaller in size

and the efficiency went

up.

Units of data storage

The basic unit of the capacity of data storage devices is bytes. A byte is eight bits. Bit

is a word formed from binary digit. A bit is a value of either a 1 or 0 (one, zero). You

have studied about these values in the unit ‘Programming’. A kilobyte is 1,000 bytes.

Then, higher units like Megabyte (MB), Gigabyte (GB) and Terabyte (TB) are formed.

In the place of Kilobyte and Megabyte units like Kibibyte (KiB) and Mebibyte (MiB)

are also used. For more details visit the link http://en.wikipedia.org/wiki/Kilobyte
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Identify the storage capacity of the hard disk in your

computer and write it down.

....................................................................................................

Connect a USB flash drive to the USB port of the

computer. Examine the storage capacity of the USB drive.

Which are the data storage devices used nowadays?

♦ Hard Disk Drive (HDD)

♦ Solid State Drive (SSD)

♦ Secure Digital Cards (SD Cards)

♦ ...........................................................................................

♦ ...........................................................................................

You may collect more details regarding this with the

help of internet.

Motherboard

You are now familiar with the components of a

computer like CPU, RAM, hard disk drive, etc. When the

computer works, all these components and other parts of

the computer have to exchange the data. How is this

possible?

This happens through the mother board or the main

board. Mother board is a complicated circuit board which

contains a number of electronic chips and electric circuits.

All these components in the computer are connected to

the mother board. The connectors of the input-output

equipment are also connected to the mother board. Slots

for connecting the expansion cards can also be seen in

the mother board. Now, you might have understood how

mother board got its name.

Switched Mode Power Supply (SMPS)

You have seen the components connected to the

mother board. Electricity is a major component for the

transfer of data. There are small and big components in
Pic. 10.4  SMPS

Paths of information
transfer

The paths used to

transfer information

between computers or

between the components

in the computer are

called bus. Nowadays

Serial Advanced

Technology Attachment

(SATA) cables are used to

connect DVD drive and

hard disk drive to the

mother board. This helps

for speedy transfer of

information.
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the computer. Do all these components need the same

quantity of power? Regular and accurate quantity of

power supply to components like mother board,

processor, hard disk, DVD drive, etc. is carried out the

equipment called  Switched Mode Power Supply (SMPS)

(Pic. 10.4).

What process should be started when you power on

the computer? You know that the operating system is in

the hard disk. This should reach the RAM which is the

temporary memory. All the components including the

CPU should become functional. Where will these

components get the instructions from?

Examine Illustration 10.2. All these components

function from the instructions they get from the chip called

Basic Input Output System (BIOS)  which is fixed in the

mother board.

When you switch the power on, the first process that

take place inside the system unit is known as  Power-on

Self-test (POST). This is a test to examine whether the

components in the computer are functioning properly.

What happens after the ‘Power-on Self-test’?

Booting is a process by which the operating system

in the hard disk starts functioning.

Will the date and time go wrong even if you do not

use the computer for many days? This is always accurate

even if there is no power supply because of the function

of a CMOS battery that is fixed on the mother board near

the BIOS chip.

Activity 10.5 - Identify the major components in the

Motherboard

The mother board of a desktop computer is given in

Pic. 10.5. Observe a mother board available in your school

computer lab. Compare the mother board with the model

(Pic. 10.5) and identify the parts. Complete the table given

(Table 10.3).

Illustration 10.2

System on Chip (SOC)

These are Chips in which

all the components of the

computer are included in

one integrated circuit.

The processor, RAM,

data storage systems,

USB ports, etc. are all

included in one Chip. In

the processors of tablets

and smart phones, along

with the CPU, facilities for

receiving audio, video

and wireless will be

included.

Flowchart of Booting
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Pic. 10.5   Model of Mother Board

Green computing

Green computing is the environment friendly way of designing, manufacturing and

using electronic devices. It also includes the disposition of defunct materials and

wastes in an effective manner.

The worn out computer parts, damaged or complaint phones and other electronic

wastes have become causes for pollution. Electronic wastes (E-wastes) affects living

beings and environment badly.

Buying more durable equipment, using less energy consumable equipment, etc. are

aspects of green computing. What else can we do in this respect?

♦ Properly shut down the electronic equipment and computer after you have

finished working on it.

♦ Take less prints in papers.

♦ ....................................................................................................................................

♦ ....................................................................................................................................

No. in
the

picture

Name of the component
in the mother board

1

2

3

4

5

� Processor socket

� ....................................

� ......................................

� BIOS chip

� .......................................6

� .......................................

Table 10.3  Components in

Motherboard
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What will happen next?

Innovative development in the field of science and

technology has brought about drastic changes in the shape and

working of computers. The uses and services of computers have

encroached almost all sectors. This has moved beyond the

mobile phones and computers to the concept of Ubiquitous

computing. The facilities of the computer and its services in the

future can only be dreamt of.

The learner:

Ubiquitous computing

Ubiquitous computing is a situation in which the computer technology reaches you

at the place where you are in the world. This can be used in any instrument, in any

place and in any manner you like. Imagine a situation in which the internet, mobile

phones, electronic chips, Global Positioning System (GPS), etc. come to  your help

even if you are on the road, or in a vehicle or in the kitchen.

For more details: https://en.wikipedia.org/wiki/Ubiquitous_computing

Significant learning outcomes

♦ fixes and turns on the cabinet of the computer, the input and output devices in the
proper manner.

♦ gets a knowledge about the various visual display units and the display port
technology which is used to connect them using HDMI and DVI and tabulate them.

♦ uses applications like Sysinfo, Disks, etc. to identify various components in a
computer, its features and storage capacity.

♦ identifies and tabulates the ports and slots for connecting the components to the
mother board.

♦ collects, prepares and present notes based on the changes that happens to the
information technology sector.
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1. Find the odd man out and explain.

a) HDMI b) DVI c) Display port      d) Network cable

2. Where does the computer get the instruction to load the operating system when

you switch on the computer?

a) Hard disk b) SMPS

c) DVD drive d) BIOS chip

3. Which one of the following does the speed of the computer depend on?

a) Frequency of the processor

b) Storage capacity of the RAM

c) Cache memory of the processor

d) All of these

Follow-up activities

♦ Conduct a hardware exhibition in your school collecting the unused or damaged

parts of the computer as part of the school IT corner activities. Exhibit the computer

parts with their details in writing.

♦ Compare the features like storage capacity, processor, RAM, etc. of various

smartphones from the details you can collect from newspaper advertisements.

♦ Conduct a seminar in your class on the changes that had occurred to the following

components. You may collect details from the Internet. You may divide the class

into groups and assign each component to each group. You can present it including

pictures with the help of the presentation software.

a. mouse b. keyboard c. processor d. monitor

♦ List down the E-waste materials in your school and house. Suggest ways to eradicate

them safely and publish the details in the school notice board.

Let’s evaluate
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